
 

500-003-XMP (US) Rev. Draft04.1-29June2021  

 

 

 
 

 
 
 

    500-003-XMP 
 
 

  104 Extraction-Free Sample-Direct Tests 
 
 

Instructions For Use  
 
 
 
For In Vitro Diagnostic Use       
For Emergency Use Authorization (EUA) Only 
 
For use with: 
Applied Biosystems QuantStudioTM 5 and 7500 Fast Dx 
Bio-Rad CFX96 TouchTM and CFX384 TouchTM  

 

 
 
 
 
 
 
 



XfreeTM COVID-19 Direct RT-PCR  
Multi-Platform 

 

 
Page 2 of 60                   500-003-XMP (US) Rev. Draft04.1-29June2021  

 

            

Table of Contents 
Table of Contents  2 

 
INTENDED USE 3SUMMARY AND EXPLANATION OF THE TEST
 3PRINCIPLES OF THE PROCEDURE
 4REAGENTS REQUIRED (PROVIDED)
 5EQUIPMENT AND MATERIALS REQUIRED BUT NOT PROVIDED
 5WARNINGS AND PRECAUTIONS
 7REAGENT STORAGE AND STABILITY
 8SPECIMEN COLLECTION, STORAGE, AND HANDLING
 8INSTRUCTIONS FOR USE
 9RT-PCR SET-UP - DIRECT PATIENT SAMPLE
 11RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE
 15QUALITY CONTROL
 20RESULTS INTERPRETATION
 22REPEAT TESTING FOR INSTRUMENT FAILURE
 24LIMITATIONS OF THE PROCEDURE
 24PERFORMANCE CHARACTERISTICS
 26REFERENCES
 33APPENDIX A: Applied Biosystems QuantStudioTM 5 Thermocycling Programing
 34APPENDIX B: Applied Biosystems 7500 Fast Dx - Thermocycling Programing
 40APPENDIX C: Bio-Rad CFX96 TouchTM  - Thermocycling Programing
 45APPENDIX D: Bio-Rad CFX384 TouchTM  - Thermocycling Programing
 50APPENDIX E: EUO LABELING
 57APPENDIX F REVISION HISTORY
 58 

  



XfreeTM COVID-19 Direct RT-PCR  
Multi-Platform 

 

 
Page 3 of 60                   500-003-XMP (US) Rev. Draft04.1-29June2021  

 

INTENDED USE 
 
The BioGX XfreeTM COVID-19 Direct RT-PCR (XfreeTM COVID-19) assay is a real-time RT-
PCR test intended for the qualitative detection of nucleic acid from the SARS-CoV-2 virus 
in nasopharyngeal, anterior nasal, mid-turbinate, and oropharyngeal swab specimens, 
nasopharyngeal wash/aspirate or nasal aspirates obtained from individuals suspected of 
COVID-19 by their healthcare provider. Testing is limited to laboratories certified under 
the Clinical Laboratory Improvement Amendments of 1988 (CLIA), 42 U.S.C. §263a, that 
meet requirements to perform high complexity tests. 
 
Results are for the identification of SARS-CoV-2 RNA. SARS-CoV-2 RNA is generally 
detectable in upper respiratory specimens during the acute phase of infection. Positive 
results are indicative of the presence of SARS-CoV-2 RNA; clinical correlation with patient 
history and other diagnostic information is necessary to determine patient infection 
status. Positive results do not rule out bacterial infection or co-infection with other 
viruses. The agent detected may not be the definite cause of the disease. Laboratories 
within the United States and its territories are required to report all results to the 
appropriate public health authorities. 
 
Negative results do not preclude SARS-CoV-2 infection and should not be used as the sole 
basis for patient management decisions. Negative results must be combined with clinical 
observations, patient history, and epidemiological information.  
 
The XfreeTM COVID-19 assay is intended for use by qualified clinical laboratory personnel 
specifically instructed and trained in the techniques of real-time PCR in vitro diagnostic 
procedures. The XfreeTM COVID-19 assay is only for use under the Food and Drug 
Administration’s Emergency Use Authorization. 

SUMMARY AND EXPLANATION OF THE TEST 
 
Severe Acute Respiratory Syndrome Coronavirus 2 (SARS-CoV-2) is the novel 
betacoronavirus that causes the COVID-19 respiratory disease. The COVID-19 respiratory 
disease is transmitted amongst infected humans within populations via respiratory 
droplets from talking, coughing, and sneezing1,2. Symptoms of COVID-19 range from mild 
illness (dry cough, fatigue, fever, and shortness of breath) to severe illness and death1.  
  
COVID-19 was first identified on December 31, 2019, amongst patients suffering from 
pneumonia in Wuhan, China1,2. SARS-CoV-2 is the seventh coronavirus identified as a 
human pathogen that likely evolved within an animal host or within humans following 
zoonotic transfer3. 
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As of September 29, 2020, the WHO has confirmed 33,034,598 infections and 996,342 
COVID-19 related deaths globally2. The elderly, immunocompromised, and those with 
cardiovascular disease, diabetes, and chronic respiratory disease have been shown to be 
at higher risk for severe illness1,2.  Ahead of global vaccination efforts, patient testing and 
social distancing measures mandated by world governments have proven to be the only 
way to stem transmission rates. 
 
BioGX XfreeTM COVID-19 assay is a real-time RT-PCR test that utilizes primer and probe 
sequences based on the United States Centers for Disease Control and Prevention (US 
CDC) assay for detection of SARS-CoV-2 (N1 gene region) and human RNase P4,5,6. 
Additionally, a non-naturally occurring single-stranded RNA has been integrated into the 
lyophilized format to serve as an internal amplification control.  
 
The PCR assay is a multiplex test that utilizes a BioGX Sample-ReadyTM lyophilized reagent 
provided in 2 mL vials. Each vial contains all PCR components such as primers, probes, 
enzymes, dNTPs, MgCl2, Internal Amplification Control RNA (IAC), and buffers required 
for real-time RT-PCR-based testing.  The assay has been validated utilizing two different 
workflows, the direct workflow in which patient sample is added directly to the 
reconstituted BioGX RT-PCR mix without any pre-processing or extraction steps, and the 
non-direct workflow that requires nucleic acid extraction using the QIAGEN QIAamp Viral 
RNA Mini Kit. Each lyophilized vial contains enough material to test 104 direct patient 
samples or 160 extracted/purified nucleic acid samples with one the following platforms: 

-Applied Biosystems QuantStudioTM 5 utilizing Design & Analysis software version 
1.5.1  
-Applied Biosystems 7500 Fast Dx utilizing SDS software version 1.4.1.   
-Bio-Rad CFX96 TouchTM utilizing Maestro software version 1.1  
-Bio-Rad CFX384 TouchTM utilizing Maestro software version 1.1  

 
Applied Biosystems QuantStudio 5 trademark is the property of ThermoFisher Scientific.  
Bio-Rad CFX96 Touch and Bio-Rad CFX384 Touch trademarks are the property of Bio-Rad Laboratories. 
 

PRINCIPLES OF THE PROCEDURE 
 
The BioGX XfreeTM COVID-19 assay is to be used with the Applied Biosystems 
QuantStudioTM 5, Applied Biosystems 7500 Fast Dx, Bio-Rad CFX96 TouchTM or Bio-Rad 
CFX384 TouchTM platforms with direct patient sample or extracted patient sample. The 
template RNA is reverse transcribed into cDNA and target sequences are PCR amplified. 
The amplified target(s) is (are) detected during amplification using hydrolysis probes 
labeled at one end with a fluorescent reporter dye (fluorophore) and at the other end 
with a quencher moiety. Probes labeled with different fluorophores are used to detect 
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specific amplicons originating from SARS CoV-2 (N1), RNase P, and Internal Amplification 
Control in the following optical channels:  
 

● RNase P      FAM equivalent channel 
● unused     HEX equivalent channel 
● SARS-CoV-2 (N1)     Texas Red equivalent channel 
● Internal Amplification Control   Cy 5 equivalent channel 
● unused      Cy 5.5 equivalent channel 

 
When the probes are in their native state, the fluorescence of the fluorophore is 
quenched due to its proximity to the quencher. However, in the presence of their specific 
target cDNA, the probes hybridize to their complementary sequences and are then 
hydrolyzed by the 5’-3’ exonuclease activity of the DNA polymerase as it synthesizes the 
nascent strand along the cDNA template. As a result, the fluorophores are separated from 
their quencher molecules and fluorescence is emitted. The Applied Biosystems 
QuantStudioTM 5, Applied Biosystems 7500 Fast Dx, Bio-Rad CFX96 TouchTM or Bio-Rad 
CFX384 TouchTM platforms measure these signals at the end of each amplification cycle 
in real time and interpret the data to provide a qualitative result for each of the above 
targets. A positive result for the detection of target RNA is indicated by the presence of a 
real-time PCR growth curve and an associated Ct (Cycle threshold) value. 
 

REAGENTS REQUIRED (PROVIDED) 
 

 
Qty 

 
REF 

 
Contents 

No. Tests 
Direct 
Format 

No. Tests 
Extracted 

Format 
4 vials 500-003-XMP BioGX XfreeTM COVID-19 Direct RT-PCR  

- Multi-Platform Sample-ReadyTM 
lyophilized PCR Master Mix containing 
polymerase, reverse transcriptase, primers, 
probes, dNTPs, MgCl2, Internal Amplification 
Control RNA (IAC), and buffers 

104   
 

160  
 

NOTE: Safety Data Sheets (SDS) are available at www.biogx.com or by request. 
 

EQUIPMENT AND MATERIALS REQUIRED BUT NOT PROVIDED 
● RNA Control (External Control): 

o ZeptoMetrix (catalog number: NATSARS(CoV2)-ST) or  
o BioGX Synthetic Nucleocapsid Phosphoprotein Gene Region (N1) (catalog 

no. 720-0206)  
● Sterile DNAse/RNAse free 1.5 mL snap cap tubes  
● BioGX Molecular Grade Water or equivalent 
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o BioGX Rehydration Water Part number: 800-0035-12  
● Sterile swab collection device appropriate for nasopharyngeal, anterior nasal, 

mid-turbinate or oropharyngeal swab collections 
● Copan universal transport media (UTMⓇ) collection kit 
● Copan ESwabTM collection kit 
● BDTM universal viral transport (UVT) collection kit 
● Sterile viral transport media (VTM)  
● Sterile saline (0.85% NaCl) 
● Vortex Genie 2 Vortexer (VWR catalog no. 58815-234) or equivalent 
● Disposable nitrile gloves 
● Calibrated Manual or Repeater Pipettes capable of accurately dispensing: 2 µL, 

10 µL, 100 µL, 1000 µL 
● Sterile DNAse/RNase free filter tip pipette tips  
● Optional if using extraction:  QIAGEN QIAamp Viral RNA Mini Kit (REF 52906) 

o Centrifuge compatible with QIAGEN extraction kit tubes 
● Applied Biosystems QuantStudio 5 (0.2 mL) with Design & Analysis software 

v1.5.1 and consumables 
o Thermo Fisher optical 8-tube strip (catalog no. 4316567) 
o Thermo Fisher ultra-clear optical caps, strips of 8 (catalog no. AB-0866) 
o Thermo Fisher 96-well optical clear reaction plates (catalog no. A36924) 
o Thermo Fisher 96-well qPCR plate seals (catalog no. AB-1170) 

● Applied Biosystems 7500 Fast Dx (0.1 mL) with SDS software v1.4.1 and 
consumables 

o Thermo Fisher optical 8-tube strip (catalog no. 4358293) 
o Thermo Fisher ultra-clear optical caps, strips of 8 (catalog no. 4323032) 
o Thermo Fisher 96-well optical reaction plates (catalog no. 4346906) 
o Thermo Fisher 96-well qPCR plate seals (catalog no. 4311971) 

● Bio-Rad CFX96 Touch with Maestro software v1.1 and consumables 
o Bio-Rad 8-tube PCR strips without caps (catalog no. TLS0851) 
o Bio-Rad Optical flat 8-cap strips for PCR tubes (catalog no. TCS0803) 
o Bio-Rad 96-well plates (catalog no. HSP9655) 
o Bio-Rad 96-well plate sealing film, optical (catalog no. MSB1001) 

● Bio-Rad CFX384 Touch with software v1.1 and consumables 
o Bio-Rad 384-well plates (catalog no. HSP3905) 
o Bio-Rad 384-well plate sealing film, optical (catalog no. MSB1001) 
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WARNINGS AND PRECAUTIONS 
  

● For in vitro diagnostic use.  
● For prescription use only. 
● For use under an Emergency Use Authorization (EUA) only. 
● The XfreeTM COVID-19 assay has not been FDA cleared or approved, but has been 

authorized by FDA under an EUA for use by authorized laboratories; laboratories 
certified under the Clinical Laboratory Improvement Amendments (CLIA) of 1988, 42 
U.S.C. § 263a, that meet requirements to perform high complexity tests.  

● The XfreeTM COVID-19 assay has been authorized only for the detection of nucleic 
acid from SARS-CoV-2, not for any other viruses or pathogens. 

● The emergency use of this product is only authorized for the duration of the 
declaration that circumstances exist justifying the authorization of emergency use of 
in vitro diagnostics for detection and/or diagnosis of COVID-19 under Section 
564(b)(1) of the Federal Food, Drug, and Cosmetic Act, 21 U.S.C. § 360bbb-3(b)(1), 
unless the declaration is terminated or authorization is revoked sooner. 

● If infection with SARS-CoV-2 is suspected based on current clinical screening criteria 
recommended by public health authorities, specimens should be collected with 
appropriate infection control precautions.  

● Specimen processing should be performed in accordance with national biological 
safety regulations.  

● Treat all biological specimens as if capable of transmitting infectious agents in 
accordance with safe laboratory procedures such as those described in CLSI 
Document M297 and in Biosafety in Microbiological and Biomedical Laboratories8. 

 ● Performance characteristics of this test have been established only with the 
specimen types listed in “Intended Use” section. The performance of this assay with 
other specimen types or samples has not been evaluated. 

 ● Do not use the reagents if the protective pouches are open or torn upon arrival. 
 ● Close reagent protective pouches promptly with the zip seal after each use.  

Remove any excess air in the pouches prior to sealing and store at 2-8 °C. 
 ● Do not remove desiccant from the PCR master mix pouches. 
 ● Do not use master mix if the desiccant is not present or is broken inside the 

pouches. 
 ● Do not use reagent vials if they are opened or damaged. 
 ● Do not mix reagents from different pouches and/or kits and/or lots. 

● Do not use expired reagents and/or materials. 
 ● Do not pipette by mouth. 
 ● Do not smoke, drink, or eat in areas where specimens or kits are being handled. 
 ● Dispose of unused reagents and waste in accordance with country, federal, 

provincial, state, and local regulations. 
● Clean and disinfect all surfaces with a 10% bleach solution followed by molecular 

grade water.  
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● Use clean gloves when handling PCR reagents. 
  

 

REAGENT STORAGE AND STABILITY 
  
 
 

● Reagents have been tested to demonstrate optimal performance when stored 
properly at 2-8°C and consumed by the expiration date on the kit label. 

 

 
● Avoid exposing the reagents (lyophilized or rehydrated) to direct sunlight or long-

term ambient lighting. 

● Discard unused rehydrated master mix if not used immediately. Re-use may result 
in contamination and false results. 

● If pouched is opened by the user but lyophilized reagent is not rehydrated, avoid 
exposure of lyophilized reagent to moisture. 

  

SPECIMEN COLLECTION, STORAGE, AND HANDLING 
Wear gloves when handling Copan Universal Transport Media (UTM), BD Universal Viral 
Transport (UVT), Copan ESwab™, or Saline collected specimens. If gloves come 
in contact with the specimen, immediately change gloves to prevent contamination of 
other specimens. 
  
Collection:  Nasopharyngeal/Oropharyngeal swab specimens should be collected 
according to the manufacturer’s instructions for use. Swab specimens should be 
collected using only swabs with a synthetic tip, and an aluminum or plastic shaft. 
Calcium alginate swabs are not acceptable and cotton swabs with wooden shafts are not 
recommended. Place swabs immediately into sterile tubes containing either 3 mL of 
viral transport media (UTM/VTM) or 1 mL of modified liquid Amies media (ESwab™). 
 

Nasopharyngeal swab (NP): Insert a swab into nostril parallel to the palate. Swab 
should reach depth equal to distance from nostrils to outer opening of the ear. 
Leave swab in place for several seconds to absorb secretions. Slowly remove 
swab while rotating it.  
Oropharyngeal swab (e.g., throat swab, OP): Swab the posterior pharynx, 
avoiding the tongue.  
Anterior Nasal Swab (NS): Using a flocked or spun polyester swab, insert the 
swab at least 1 cm (0.5 inch) inside the nostril (naris) and firmly sample the nasal 
membrane by rotating the swab and leaving in place for 10 to 15 seconds. 
Sample both nostrils with same swab.  
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Storage:  Specimens may be stored at 2-8°C for up to 72 hours after collection. If a delay 
in testing or shipping is expected, store specimens at -70°C or below.  
 
Shipping:  Specimens must be packaged, shipped, and transported according to the 
current edition of the International Air Transport Association (IATA) Dangerous Goods 
Regulation. Store specimens at 2-8°C and ship overnight to the lab on ice pack. 
Specimens frozen at -70°C are shipped overnight to the lab on dry ice.  
 
Additional information on packing, shipping, and transporting of specimens can be 
found at Interim Laboratory Biosafety Guidelines for Handling and Processing Specimens 
Associated with Coronavirus Disease 2019 (COVID-19). 
  
For further guidance on specimen collection, storage and handling from patients 
suspected to be infected with SARS-CoV-2,  reference the following CDC Interim 
Guidelines: https://www.cdc.gov/coronavirus/2019-nCoV/lab/guidelines-clinical-
specimens.html.  
 
 

INSTRUCTIONS FOR USE 

Instrument Templates/Protocols and Programming 

Please refer to Appendix E for appropriate EUO labeling of instrument platforms. 

Applied Biosystems QuantStudioTM 5  
(Operating software: Design & Analysis Software v1.5.1) 
 
Install the BioGX Protocol on the Applied Biosystems QuantStudioTM 5 
It will be necessary to import the Applied Biosystems QuantStudioTM 5 template.  The 
most current Applied Biosystems QuantStudioTM 5 template is available for download at 
www.biogx.com. Follow the ‘Education Center’ tab in the navigation menu at the top of 
the home page. Select "US Product Documents”. Follow the “XfreeTM Direct RT-PCR 
Documents” tab. Choose the appropriate product number and follow the “Run Files” link 
to the platform of choice. Download the Applied Biosystems QuantStudioTM 5 template. 
Alternatively, the Applied Biosystems QuantStudioTM 5 template can also be obtained by 
emailing BioGX at covid19@biogx.com. To manually program the thermocycler, please 
refer to Appendix A. For further instrument information, please refer to the Applied 
Biosystems QuantStudioTM 5 user manual9. 
 
 

https://www.cdc.gov/coronavirus/2019-nCoV/lab/guidelines-clinical-specimens.html
https://www.cdc.gov/coronavirus/2019-nCoV/lab/guidelines-clinical-specimens.html
mailto:covid19@biogx.com
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Applied Biosystems 7500 Fast Dx  
(Operating software: SDS Software v1.4.1) 
 
Install the BioGX Protocol on the Applied Biosystems 7500 Fast Dx 
It will be necessary to import the Applied Biosystems 7500 Fast Dx template.  The most 
current Applied Biosystems 7500 Fast Dx template is available for download at 
www.biogx.com. Follow the “Education Center” tab in the navigation menu at the top of 
the home page. Select "US Product Documents”. Follow the “XfreeTM Direct RT-PCR 
Documents” tab. Choose the appropriate product number and follow the “Run Files” link 
to the platform of choice. Download the Applied Biosystems 7500 Fast Dx template. 
Alternatively, the Applied Biosystems 7500 Fast Dx template can also be obtained by 
emailing BioGX at covid19@biogx.com. To manually program the thermocycler, please 
refer to Appendix B. For further instrument information, please refer to the Applied 
Biosystems 7500 Fast Dx user manual10. 
 

Bio-Rad CFX96 TouchTM 
(Operating software: MaestroTM 1.1) 
 
Install the BioGX Protocol on the Bio-Rad CFX96 TouchTM 
It will be necessary to import the Bio-Rad CFX96 TouchTM Protocol and Plate files. The 
most current versions of the Bio-Rad CFX96 TouchTM Protocol and Plate files are available  
for download on www.biogx.com.  Follow the “Education Center” tab in the navigation 
menu at the top of the home page. Select "US Product Documents”. Follow the “XfreeTM 
Direct RT-PCR Documents” tab. Choose the appropriate product number and follow the 
“Run Files” link to the platform of choice.  Download the Bio-Rad CFX96 TouchTM Protocol 
and Plate files. Alternatively, the Bio-Rad CFX96 TouchTM Protocol and Plate files can also 
be obtained by emailing BioGX at covid19@biogx.com. To manually program the 
thermocycler, please refer to Appendix C. For further instrument information, please 
refer to the Bio-Rad CFX96 TouchTM user manual11. 
 

Bio-Rad CFX384 TouchTM 
(Operating software: MaestroTM 1.1) 
 
Install the BioGX Protocol on the Bio-Rad CFX384 TouchTM 
It will be necessary to import the Bio-Rad CFX384 TouchTM Protocol and Plate files. The 
most current versions of the Bio-Rad CFX384 TouchTM Protocol and Plate files are 
available for download on www.biogx.com. Follow the “Education Center” tab in the 
navigation menu at the top of the home page. Select "US Product Documents”. Follow 
the “XfreeTM Direct RT-PCR Documents” tab. Choose the appropriate product number and 
follow the “Run Files” link to the platform of choice.   Download the Bio-Rad CFX384 
TouchTM Protocol and Plate files. Alternatively, the Bio-Rad CFX384 TouchTM Protocol and 
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Plate files can also be obtained by emailing BioGX at covid19@biogx.com. To manually 
program the thermocycler, please refer to Appendix D. For further instrument 
information, please refer to the Bio-Rad CFX384 TouchTM user manual11. 
      
 

 RT-PCR SET-UP - DIRECT PATIENT SAMPLE 
 
Follow the “RT-PCR Set-up - Direct Patient Sample” section below for the appropriate 
real-time PCR platform (i.e. QuantStudioTM 5, 7500 Fast Dx, CFX96 TouchTM and CFX384 
TouchTM). 
 

Applied Biosystems QuantStudioTM 5 
 

 

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to reduce 
the generation of static charges. DO NOT use latex gloves. 

 

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates. 
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of 

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more 
than sufficient for 26 samples to be tested by direct sample addition.  

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep 
rehydrated master mix in a cold block or on ice if set-up cannot be completed 
within 20 minutes. If the rehydrated master mix cannot be used immediately, it 
should be discarded. 

5. Transfer 15 μL of rehydrated master mix to the bottom of 26 empty wells (8-tube 
PCR strips or 96-well PCR plate). 

6. To each well containing 15 μL of rehydrated master mix, add 5 μL of direct patient 
sample. 

7. Affix the appropriate optical caps or optical plate seals. 
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom. 
9. Load 8-tube PCR strips and/or 96-well PCR plates into the real-time PCR platform 

and start run. Avoid unnecessary delay once tubes/plates are loaded. 
10. Refer to Table 2 for result interpretation. 

 
Note: For Applied Biosystems QuantStudioTM 5 template file for Direct Patient Sample 
addition (500003XMPDirectQS5v2.edt), please refer to the section: “Instrument 
Templates and Programming”: Install the BioGX Protocol on the Applied Biosystems 
QuantStudioTM 5 for download instructions. To manually program the thermocycler, 
please refer to Appendix A. 
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RT-PCR SET-UP - DIRECT PATIENT SAMPLE 
 

Applied Biosystems 7500 Fast Dx 
 

 

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to reduce 
the generation of static charges. DO NOT use latex gloves. 

 

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates. 
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of 

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more 
than sufficient for 26 samples to be tested by direct sample addition.  

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep 
rehydrated master mix in a cold block or on ice if set-up cannot be completed 
within 20 minutes. If the rehydrated master mix cannot be used immediately, it 
should be discarded. 

5. Transfer 15 μL of rehydrated master mix to the bottom of 26 empty wells (8-tube 
PCR strips or 96-well PCR plate). 

6. To each well containing 15 μL of rehydrated master mix, add 5 μL of direct patient 
sample. 

7. Affix the appropriate optical caps or optical plate seals. 
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom. 
9. Load 8-tube PCR strips and/or 96-well PCR plates into the real-time PCR platform 

and start run. Avoid unnecessary delay once tubes/plates are loaded. 
10. Refer to Table 2 for result interpretation. 

 
Note: For Applied Biosystems 7500 Fast Dx template file for Direct Patient Sample 
addition (500003XMPDirect7500Dx.sdt), please refer to the section: “Instrument 
Templates and Programming”: Install the BioGX Protocol on the Applied Biosystems 
7500 Fast Dx  for download instructions. To manually program the thermocycler, please 
refer to Appendix B. 

  
 

 
 
 
 
 
 
 
 
 
RT-PCR SET-UP - DIRECT PATIENT SAMPLE 
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Bio-Rad CFX96 TouchTM 
 

 

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to reduce 
the generation of static charges. DO NOT use latex gloves. 

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates. 
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of 

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more 
than sufficient for 26 samples to be tested by direct sample addition.  

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep 
rehydrated master mix in a cold block or on ice if set-up cannot be completed 
within 20 minutes. If the rehydrated master mix cannot be used immediately, it 
should be discarded. 

5. Transfer 15 μL of rehydrated master mix to the bottom of 26 empty wells (8-tube 
PCR strips or 96-well PCR plate). 

6. To each well containing 15 μL of rehydrated master mix, add 5 μL of direct patient 
sample. 

7. Affix the appropriate optical caps or optical plate seals. 
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom. 
9. When CFX96 TouchTM run is completed, threshold setting update will need to be 

completed as follows: 
a. Open the “Data Analysis” window for your specific run 
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel 

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold 
adjustments can be performed only in single threshold mode, be sure only 
one dye is selected) 
i. Navigate to “Settings” and select “Baseline Threshold” 
ii. At the bottom of the popup window under “single threshold”, select 

“User Defined” and enter “500”  
iii. Click “OK” and the threshold for FAM will apply to the experiment. 

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel 
and Quasar 670-channel and be sure “CalRed 610” is checked (Note: 
Threshold adjustments can be performed only in single threshold mode, 
be sure only one dye is selected) 
i. Navigate to “Settings” and select “Baseline Threshold” 
ii. At the bottom of the popup window under “single threshold”, select 

“User Defined” and enter “500”  
iii. Click “OK” and the threshold for CalRed 610 will apply to the 

experiment 
d. To apply threshold settings for Quasar 670-channel, uncheck FAM-

channel and CalRed 610-channel and be sure “Quasar 670” is checked 
(Note: Threshold adjustments can be performed only in single threshold 
mode, be sure only one dye is selected) 
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i. Navigate to “Settings” and select “Baseline Threshold” 
ii. At the bottom of the popup window under “single threshold”, select 

“User Defined” and enter “500”  
iii. Click “OK” and the threshold for Quasar 670 will apply to the 

experiment 
10. Refer to Table 2 for result interpretation. 

 
Note: For Bio-Rad CFX96 TouchTM protocol and plate files for Direct Patient Sample 
addition (500003XMPDirectCFX96v2.prcl and 500003XMPDirect_plateCFX96v2.pltd), 
please refer to the section: “Instrument Templates and Programming”: Install the 
BioGX Protocol on the Bio-Rad CFX96 TouchTM  for download instructions. To manually 
program the thermocycler, please refer to Appendix C. 
 

 
RT-PCR SET-UP - DIRECT PATIENT SAMPLE 
 

Bio-Rad CFX384 TouchTM 
 

 

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to reduce 
the generation of static charges. DO NOT use latex gloves. 

2. Prepare the appropriate number of 384-well PCR plates. 
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of 

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more 
than sufficient for 26 samples to be tested by direct sample addition.  

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep 
rehydrated master mix in a cold block or on ice if set-up cannot be completed 
within 20 minutes. If the rehydrated master mix cannot be used immediately, it 
should be discarded. 

5. Transfer 15 μL of rehydrated master mix to the bottom of 26 empty wells (384-
well PCR plate). 

6. To each well containing 15 μL of rehydrated master mix, add 5 μL of direct patient 
sample. 

7. Affix the appropriate optical caps or optical plate seals. 
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom. 
9. When CFX384 TouchTM run is completed, threshold setting update will need to be 

completed as follows: 
a. Open the “Data Analysis” window for your specific run 
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel 

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold 
adjustments can be performed only in single threshold mode, be sure only 
one dye is selected) 
i. Navigate to “Settings” and select “Baseline Threshold” 
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ii. At the bottom of the popup window under “single threshold”, select “User 
Defined” and enter “500”  

iii. Click “OK” and the threshold for FAM will apply to the experiment. 
d. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel 

and Quasar 670-channel and be sure “CalRed 610” is checked (Note: 
Threshold adjustments can be performed only in single threshold mode, be 
sure only one dye is selected) 
i. Navigate to “Settings” and select “Baseline Threshold” 
ii. At the bottom of the popup window under “single threshold”, select “User 

Defined” and enter “250”  
iii. Click “OK” and the threshold for CalRed 610 will apply to the experiment 

e. To apply threshold settings for Quasar 670-channel, uncheck FAM-channel 
and CalRed 610-channel and be sure “Quasar 670” is checked (Note: 
Threshold adjustments can be performed only in single threshold mode, be 
sure only one dye is selected) 
i. Navigate to “Settings” and select “Baseline Threshold” 
ii. At the bottom of the popup window under “single threshold”, select “User 

Defined” and enter “500”  
iii. Click “OK” and the threshold for Quasar 670 will apply to the experiment 

10. Refer to Table 2 for result interpretation. 
 
Note: For Bio-Rad CFX384 TouchTM protocol and plate files for Direct Patient Sample 
addition (500003XMPDirectCFX384.prcl and 500003XMPDirect_plateCFX384.pltd), 
please refer to the section: “Instrument Templates and Programming”: Install the 
BioGX Protocol on the Bio-Rad CFX384 TouchTM for download instructions. To manually 
program the thermocycler, please refer to Appendix D. 

 
 

RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE 
 
Follow the “RT-PCR Set-up - Extracted Patient Sample” section below for the 
appropriate real-time PCR platform (i.e. QuantStudioTM 5, 7500 Fast Dx, CFX96 TouchTM 
and CFX384 TouchTM). For the validated QIAGEN QIAamp Viral RNA Mini Kit extraction 
method (manual), pipette 140µL of specimen into the extraction tube/plate and 
proceed with the protocol as per the manufacturer’s instructions for use (Purification of 
Viral RNA (Spin Protocol)). Elute each sample in 50µL RNAse-free water. After extraction 
and elution, add 5 µL of the eluate to the RT-PCR master mix. 
 

Applied Biosystems QuantStudioTM 5 
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1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to reduce 
the generation of static charges. DO NOT use latex gloves. 

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates. 
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of 

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more 
than sufficient for 40 samples to be tested using purified nucleic acid samples.  

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep 
rehydrated master mix in a cold block or on ice if set-up cannot be completed 
within 20 minutes. If the rehydrated master mix cannot be used immediately, it 
should be discarded. 

5. Transfer 10 μL of rehydrated master mix to the bottom of 40 empty wells (8-tube 
PCR strips or 96-well PCR plate). 

6. To each well containing 10 μL of rehydrated master mix, add 5 μL of extracted 
patient sample. 

7. Affix the appropriate optical caps or optical plate seals. 
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom. 
9. Load 8-tube PCR strips and/or 96-well PCR plates into the real-time PCR platform 

and start run. Avoid unnecessary delay once tubes/plates are loaded. 
10. Refer to Table 2 for result interpretation. 

 
Note: For Applied Biosystems QuantStudioTM 5 template file for Extracted Patient 
Sample addition (500003XMPExtractQS5v2.edt), please refer to the section: “Instrument 
Templates and Programming”: Install the BioGX Protocol on the Applied Biosystems 
QuantStudioTM 5 for download instructions. To manually program the thermocycler, 
please refer to Appendix A. 

 
RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE 
 

Applied Biosystems 7500 Fast Dx 
 

 

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to reduce 
the generation of static charges. DO NOT use latex gloves. 

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates. 
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of 

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more 
than sufficient for 40 samples to be tested using purified nucleic acid samples.  

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep 
rehydrated master mix in a cold block or on ice if set-up cannot be completed 
within 20 minutes. If the rehydrated master mix cannot be used immediately, it 
should be discarded. 

5. Transfer 10 μL of rehydrated master mix to the bottom of 40 empty wells (8-tube 
PCR strips or 96-well PCR plate). 
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6. To each well containing 10 μL of rehydrated master mix, add 5 μL of extracted 
patient sample. 

7. Affix the appropriate optical caps or optical plate seals. 
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom. 
9. Load 8-tube PCR strips and/or 96-well PCR plates into the real-time PCR platform 

and start run. Avoid unnecessary delay once tubes/plates are loaded. 
10. Refer to Table 2 for result interpretation. 

 
Note: For Applied Biosystems 7500 Fast Dx template file for Extracted Patient Sample 
addition (500003XMPExtract7500Dx.sdt), please refer to the section: “Instrument 
Templates and Programming”: Install the BioGX Protocol on the Applied Biosystems 
7500 Fast Dx for download instructions. To manually program the thermocycler, please 
refer to Appendix B. 

 
 
RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE 
 

Bio-Rad CFX96 TouchTM 
 

 

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to reduce 
the generation of static charges. DO NOT use latex gloves. 

 

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates. 
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of 

lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more 
than sufficient for 40 samples to be tested using purified nucleic acid samples.  

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep 
rehydrated master mix in a cold block or on ice if set-up cannot be completed 
within 20 minutes. If the rehydrated master mix cannot be used immediately, it 
should be discarded. 

5. Transfer 10 μL of rehydrated master mix to the bottom of 40 empty wells (8-tube 
PCR strips or 96-well PCR plate). 

6. To each well containing 10 μL of rehydrated master mix, add 5 μL of extracted 
patient sample. 

7. Affix the appropriate optical caps or optical plate seals. 
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom. 
9. When CFX96 TouchTM run is completed, threshold setting update will need to be 

completed as follows: 
a. Open the “Data Analysis” window for your specific run 
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel 

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold 
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adjustments can be performed only in single threshold mode, be sure only 
one dye is selected) 
i. Navigate to “Settings” and select “Baseline Threshold” 
ii. At the bottom of the popup window under “single threshold”, select 

“User Defined” and enter “500”  
iii. Click “OK” and the threshold for FAM will apply to the experiment. 

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel 
and Quasar 670-channel and be sure “CalRed 610” is checked (Note: 
Threshold adjustments can be performed only in single threshold mode, 
be sure only one dye is selected) 
i. Navigate to “Settings” and select “Baseline Threshold” 
ii. At the bottom of the popup window under “single threshold”, select 

“User Defined” and enter “500”  
iii. Click “OK” and the threshold for CalRed 610 will apply to the 

experiment 
d. To apply threshold settings for Quasar 670-channel, uncheck FAM-

channel and CalRed 610-channel and be sure “Quasar 670” is checked 
(Note: Threshold adjustments can be performed only in single threshold 
mode, be sure only one dye is selected) 
i. Navigate to “Settings” and select “Baseline Threshold” 
ii. At the bottom of the popup window under “single threshold”, select 

“User Defined” and enter “500”  
iii. Click “OK” and the threshold for Quasar 670 will apply to the 

experiment 
10. Refer to Table 2 for result interpretation. 

 
Note: For Bio-Rad CFX96 TouchTM protocol and plate files for Extracted Patient Sample 
addition (500003XMPExtractCFX96v2.prcl and 500003XMPExtract_plateCFX96v2.pltd), 
please refer to the section: “Instrument Templates and Programming”: Install the 
BioGX Protocol on the Bio-Rad CFX96 TouchTM for download instructions. To manually 
program the thermocycler, please refer to Appendix C. 
 

RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE 
 

Bio-Rad CFX384 TouchTM 
 

 

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to reduce 
the generation of static charges. DO NOT use latex gloves. 

 2. Prepare the appropriate number of 384-well PCR plates. 
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3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of 
lyophilized BioGX XfreeTM COVID-19 reagents. The rehydrated master mix is more 
than sufficient for 40 samples to be tested using purified nucleic acid samples.  

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep 
rehydrated master mix in a cold block or on ice if set-up cannot be completed 
within 20 minutes. If the rehydrated master mix cannot be used immediately, it 
should be discarded. 

5. Transfer 10 μL of rehydrated master mix to the bottom of 40 empty wells (384-
well PCR plate). 

6. To each well containing 10 μL of rehydrated master mix, add 5 μL of direct patient 
sample. 

7. Affix the appropriate optical caps or optical plate seals. 
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom. 
9. When CFX384 TouchTM run is completed, threshold setting update will need to be 

completed as follows: 
a. Open the “Data Analysis” window for your specific run 
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel 

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold 
adjustments can be performed only in single threshold mode, be sure only 
one dye is selected) 
i. Navigate to “Settings” and select “Baseline Threshold” 
ii. At the bottom of the popup window under “single threshold”, select 

“User Defined” and enter “500”  
iii. Click “OK” and the threshold for FAM will apply to the experiment. 

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel 
and Quasar 670-channel and be sure “CalRed 610” is checked (Note: 
Threshold adjustments can be performed only in single threshold mode, 
be sure only one dye is selected) 
i. Navigate to “Settings” and select “Baseline Threshold” 
ii. At the bottom of the popup window under “single threshold”, select 

“User Defined” and enter “250”  
iii. Click “OK” and the threshold for CalRed 610 will apply to the 

experiment 
d. To apply threshold settings for Quasar 670-channel, uncheck FAM-

channel and CalRed 610-channel and be sure “Quasar 670” is checked 
(Note: Threshold adjustments can be performed only in single threshold 
mode, be sure only one dye is selected) 
i. Navigate to “Settings” and select “Baseline Threshold” 
ii. At the bottom of the popup window under “single threshold”, select 

“User Defined” and enter “500”  
iii. Click “OK” and the threshold for Quasar 670 will apply to the 

experiment 
10. Refer to Table 2 for result interpretation. 
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Note: For Bio-Rad CFX384 TouchTM protocol and plate files for Extracted Patient Sample 
addition (500003XMPExtractCFX384.prcl and 500003XMPExtract_plateCFX384.pltd), 
please refer to the section: “Instrument Templates and Programming”: Install the 
BioGX Protocol on the Bio-Rad CFX96 TouchTM for download instructions. To manually 
program the thermocycler, please refer to Appendix D. 

 
 

QUALITY CONTROL 

Controls to Monitor Assay Performance  

 

 
● Each BioGX XfreeTM COVID-19 kit includes molecular primers and probes specific 

for the detection of the human RNase P gene, a sample processing control (SPC), 
in the lyophilized RT-PCR master mix. RNase P should be present and detected in 
each patient sample. In addition, a non-naturally occurring single-stranded RNA is 
integrated into the lyophilized reagent to serve as a PCR internal amplification 
control (IAC). The IAC should be present and detected in every control and SARS-
CoV-2 negative patient sample. No external addition of the SPC or IAC is required.  

 
 
External positive and negative controls are available separately for the BioGX XfreeTM 
COVID-19 kit. The external positive control available from BioGX (BioGX Synthetic RNA 
Nucleocapsid Phosphoprotein gene region (N1) (BioGX catalog no. 720-0206) is treated 
as if it were a patient sample and should be positive for both the COVID-19 N1 target and 
the IAC target. As an alternative, inactivated SARS-CoV-2 RNA available from Zeptometrix 
(catalog number NATSARS(CoV2)-ST) may also be used as an external positive control and 
should also be positive for both the COVID-19 N1 target and the IAC target. It is 
recommended that one external positive control be included with each RT-PCR run of 
patient samples. The external negative control should consist of molecular grade water 
and should be positive only for the IAC target. It is recommended that one external 
negative control be included in each extraction batch (as applicable) and each RT-PCR run 
of patient samples. BioGX recommends that the external negative control be prepared 
prior to the external positive control in order to reduce the potential for contamination 
as a result of control preparation.  

Preparation of BioGX External Control for Direct or Extracted Sample Testing 

Positive Control [BioGX SARS-CoV-2 (N1)] 
Preparation of BioGX SARS-CoV-2 Synthetic Nucleocapsid Phosphoprotein Gene Region 
(N1) external control (catalog no. 720-0206): 
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A single BioGX lyophilized SARS-CoV-2 (N1) control bead containing 100,000 
copies/bead should be serially diluted as described in the procedure below to achieve a 
final concentration of 10,000 copies/mL (10 copies/µL).  
  

1. Rehydrate one BioGX lyophilized SARS-CoV-2 (N1) control bead with 100 µL of 
molecular grade water. Slowly pipette up and down 5 times to homogenize and 
discard pipette tip. This will be the SARS-CoV-2 (N1) stock solution. 

2. With a fresh pipette tip, prepare two microcentrifuge tubes for serial dilution by 
adding 90 µL of molecular grade water to each. Label the tube caps with “N1-10” 
and “N1-100” to represent the 1/10 dilution and 1/100 dilution of SARS-CoV-2 
(N1) stock solution, respectively.   

3. With a fresh pipette tip, transfer 10 µL of the SARS-CoV-2 (N1) stock solution to 
the first microcentrifuge tube labeled “N1-10”. Slowly pipette up and down 5 
times to homogenize then discard the pipette tip. 

4. With a fresh pipette tip, transfer 10 µL of the “N1-10” dilution to the second 
microcentrifuge tube labeled “N1-100”. Slowly pipette up and down 5 times to 
homogenize then discard the pipette tip. The microcentrifuge tube labeled “N1-
100” now contains SARS-CoV-2 (N1) control at 10,000 copies/mL. 

Add 5 μL of SARS-CoV-2 (N1) control (50 copies/PCR reaction) from the microcentrifuge 
tube labeled “N1-100” to each positive control well position(s) containing dispensed 
master mix. 

Negative Control (No Template) - Add 5 μL of molecular grade water to (1) well position 
containing dispensed master mix. 

Preparation of Zeptometrix External Positive Control for Extracted or Direct Samples  
Preparation of ZeptoMetrix SARS-Related Coronavirus 2 (SARS-CoV-2 Isolate: USA-WA1/2020) 
Zeptometrix catalog number:  NATSARS(COV2)-ST 
  
ZeptoMetrix SARS-Related Coronavirus 2 (SARS-CoV-2) stock concentration of 1,000,000 (1,000 
copies/ µL) should be serially diluted to achieve a final concentration of 10,000 copies/mL (10 
copies/µL) for the extracted method  

1.     With a fresh pipette tip, prepare two microcentrifuge tubes for serial 
dilution by adding 18 µL of molecular grade water to each tube. Label the 
tube caps with “N1-10” and “N1-100” to represent the 10 times dilution and 
100 times dilution of stock to yield 100 copies /µL and 10 copies / µL, 
respectively. 
2.     With a fresh pipette tip, transfer 2 µL of the ZeptoMetrix SARS-Related 
Coronavirus 2 (SARS-CoV-2) stock solution to the first microcentrifuge tube 
labeled “ZM-10”. Slowly pipette up and down 5 times to homogenize then 
discard the pipette tip. 
3.     With a fresh pipette tip, transfer 2 µL of the “N1-10” dilution to the 
second microcentrifuge tube labeled “N1-100”. Slowly pipette up and down 5 
times to homogenize then discard the pipette tip. The microcentrifuge tube 
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labeled “N1-100” now contains ZeptoMetrix SARS-Related Coronavirus 2 
(SARS-CoV-2) control at 10, 000 copies/mL.  
4.     Add 5 μL of SARS-CoV-2 (N1) control (50 copies/PCR reaction) from the 
microcentrifuge tube labeled “N1-100” to each positive control well 
position(s) containing dispensed master mix. 

 
Note: The BioGX SARS-CoV-2 and Zeptometrix SARS-CoV-2 positive controls, when 
utilized as described (3,333 copies/mL) with the extracted workflow, may not 
sufficiently evaluate integrity of the assay reagents and could lead to false specimen 
results. 
 
For further reference, please reference the product insert for Lyophilized Control 
Template Beads (BioGX Product Number Series 720-0206) which is available for 
download at www.biogx.com by using the drop down menu at the top right of the home 
page. Select "Education Center" then select "Product Documents". Choose the 
appropriate product number under "Template Controls". 
 

RESULTS INTERPRETATION 

Expected Results for Kit Controls 
 
All test controls should be examined prior to interpretation of patient results.  If the 
controls do not yield the expected results as shown in Table 1 below, the patient results 
cannot be interpreted.  
 
Table 1. Interpretation of BioGX external controls. 

Control 
Type 

Applicability 
for Monitoring 

N1 
Gene  

N1 
Expected 

Ct 
RNase P 

RNase P 
Expected 

Ct 
IAC IAC 

Expected Ct 

Negative 
Control - 

Addition of 
5 µL Water 

Reagent 
and/or 

environmental 
contamination 

- Not 
Detected - Not 

Detected + Ct≤30 

N1 Positive 
Control - 

BioGX 
Synthetic 
Template 
Control 

Substantial 
reagent failure 

including 
primer and 

probe integrity 

+ Ct≤40 - Not 
Detected + Ct≤30 

 
An external negative control that yields a positive result for the COVID-19 N1 gene or 
RNase P gene is indicative of errant sample handling and/or contamination. If the N1 
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target or RNase P target is amplified, the assay should be repeated with reagents from an 
unopened pouch or new assay kit.  
 
An external positive control that yields a negative result for the COVID-19 N1 target is 
indicative of a specimen handling and preparation and/or reagent problem. If N1 is not 
amplified, first review the specimen handling/preparation technique to ID 
handling/preparation errors then repeat the assay. If the issue persists, repeat with 
reagents from an unopened pouch or new assay kit.  
 
The IAC, which is present in the RT-PCR master mix, should be detected and produce a Ct 
value ≤30 for all external negative and positive control reactions. If the IAC target is not 
detected, integrity of the assay components may be compromised, and the assay should 
be repeated with reagents from an unopened pouch or new assay kit. 
 

Examination and Interpretation of Patient Specimen Results 
Assessment of clinical specimen test results should be performed after the external 
positive and negative controls have been examined and determined to be valid and 
acceptable. If the controls are not valid, the patient results cannot be interpreted. The list 
of expected results is outlined in Table 2. If results are obtained that do not follow these 
guidelines, re-test sample or re-extract and re-test the sample if using extraction. If repeat 
testing yields similar results, collect a fresh sample from the patient for testing. In the 
presence of a high concentration positive result for the target, the IAC may or may not 
amplify. This is normal. A positive test result does not necessarily indicate the presence 
of viable infectious organisms. A positive result is indicative of the presence of target 
nucleic acid. A negative test result does not preclude the presence of infectious organisms 
and should not be used as the sole basis for treatment or other patient management 
decisions. 

 
Table 2. Interpretation of patient sample results14. 

XfreeTM COVID-19 
Direct RT-PCR 

Results 

N1 gene RNase P IAC Result 
Interpretation Detect 

(+/-) Expected Ct Detect 
(+/-) Expected Ct Detect 

(+/-) 
Expected 

Ct 
SARS-CoV-2 

POSITIVE + Ct≤40 + Ct≤36 +/- Ct≤30 Report as 
POSITIVE 

SARS-CoV-2 
NEGATIVE - Not 

Detected + Ct≤36 + Ct≤30 Report as 
NEGATIVE 

Indeterminant -/+ Ct 0-40 - / Ct≥36 -/Ct≥36 + Ct≤30 Repeat Test* 

Indeterminant -/+ Ct 0-40 + Ct≤36 - / Ct≥30 - / Ct≥30 Repeat Test* 
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*Repeat the test by preparing a new test from the remaining patient sample collection and ensure the patient sample 
and PCR master mix is dispensed properly in the well being analyzed. Repeat testing must yield RNaseP and IAC 
detection without N1 detection to confirm a NEGATIVE result. However, if the same result is obtained upon a repeat 
test, report results as INCONCLUSIVE and request a new sample collection.  
 

REPEAT TESTING FOR INSTRUMENT FAILURE  
 
In case of instrument failure, repeat testing can be performed by setting up a new run 
using the original sample/specimen as described above in the “Specimen Preparation” 
section. Refer to the “Troubleshooting” section of the Applied Biosystems QuantStudioTM 
59, Applied Biosystems 7500 Fast Dx10, Bio Rad CFX96 TouchTM/CFX384 TouchTM 11 

Instruction Manuals for interpretation of warning and error codes.  
 

LIMITATIONS OF THE PROCEDURE 
● The use of this assay as an in vitro diagnostic under FDA Emergency Use 

Authorization (EUA) is limited to laboratories that are certified under the Clinical 
Laboratory Improvement Amendments of 1988 (CLIA), 42 U.S.C. § 263a, to 
perform high complexity tests. 

● This product is intended for use with specimens collected using specimen 
collection and transport devices listed in the “Equipment and Materials Required 
But Not Provided” section.  

● Incorrect test results may occur from improper specimen collection, handling or 
storage, technical error, sample mix-up, or because the number of organisms in 
the specimen is below the analytical sensitivity of the test. Careful compliance 
with the BioGX XfreeTM COVID-19 assay instructions for use and the real-time PCR 
platforms (ie. Applied Biosystems QuantStudioTM 59, Applied Biosystems 7500 Fast 
Dx10, Bio-Rad CFX96 TouchTM/CFX384 TouchTM 11) are necessary to avoid 
erroneous results. 

● Good laboratory technique is essential for the proper performance of this assay.  
● The BioGX SARS-CoV-2 positive control, when utilized at 3,333 copies/mL with the 

extracted workflow, may not sufficiently evaluate integrity of the assay reagents 
and could lead to false specimen results. 

● A positive test result does not necessarily indicate the presence of viable 
infectious organisms. A positive result is indicative of the presence of target 
nucleic acid. A negative test result does not preclude the presence of infectious 
organisms and should not be used as the sole basis for treatment or other patient 
management decisions. 

● The BioGX XfreeTM COVID-19 assay results may sometimes be Unresolved or 
Indeterminate due to a lack of RNase P and/or IAC detection. Instrument failure 
could also contribute to an incomplete run result and require retesting that can 
lead to a delay obtaining final results. 
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● The performance of the BioGX XfreeTM COVID-19 assay was established using 
nasopharyngeal swab samples. Anterior nasal, mid-turbinate, and oropharyngeal 
swab specimens, and nasopharyngeal wash/aspirate or nasal aspirates are also 
considered acceptable specimen types for use with the BioGX XfreeTM COVID-19 
assay but performance has not been established.  

● Mutations or polymorphisms in primer- or probe-binding regions may affect 
detection of new or unknown SARS-CoV-2 variants resulting in a false negative 
result with the BioGX XfreeTM COVID-19 assay. 

● The clinical performance has not been established in all circulating variants but is 
anticipated to be reflective of the prevalent variants in circulation at the time and 
location of the clinical evaluation. Performance at the time of testing may vary 
depending on the variants circulating, including newly emerging strains of SARS-
CoV-2 and their prevalence, which change over time. 

● The BioGX XfreeTM COVID-19 assay requires the use of three (3) optical channels 
on the Applied Biosystems QuantStudioTM 5, Applied Biosystems 7500 Fast Dx,   
Bio-Rad CFX96 TouchTM or Bio-Rad CFX384 TouchTM platforms. 

 

Conditions of Authorization for the Laboratory 
 
The BioGX XfreeTM COVID-19 Direct RT-PCR Letter of Authorization, along with the 
authorized Fact Sheet for Healthcare Providers, the authorized Fact Sheet for Patients, 
and authorized labeling are available on FDA website: https://www.fda.gov/medical-
devices/coronavirus-disease-2019-covid-19-emergency-use-authorizations-medical-
devices/in-vitro-diagnostics-euas.  
However, to assist clinical laboratories using the BioGX XfreeTM COVID1-9 Direct RT-PCR 
assay, the relevant Conditions of Authorization are listed below.  
 

a) Authorized laboratories1 using the BioGX XfreeTM COVID-19 Direct RT-PCR assay 
must include with test result reports, all authorized Fact Sheets. Under exigent 
circumstances, other appropriate methods for disseminating these Fact Sheets 
may be used, which may include mass media.  

b) Authorized laboratories using the BioGX XfreeTM COVID-19 Direct RT-PCR assay 
must use the BioGX XfreeTM COVID-19 Direct RT-PCR assay as outlined in the 
authorized labeling. Deviations from the authorized procedures, such as the 
authorized instruments, authorized extraction methods, authorized clinical 
specimen types, authorized control materials, authorized other ancillary reagents 
and authorized materials required to use the BioGX XfreeTM COVID-19 Direct RT-
PCR assay are not permitted.  

c) Authorized laboratories that receive the BioGX XfreeTM COVID-19 Direct RT-PCR 
assay must notify the relevant public health authorities of their intent to run the 
BioGX XfreeTM COVID-19 Direct RT-PCR assay prior to initiating testing.  
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d) Authorized laboratories using the BioGX XfreeTM COVID-19 Direct RT-PCR assay 
must have a process in place for reporting test results to healthcare providers and 
relevant public health authorities, as appropriate.  

e) Authorized laboratories must collect information on the performance of the BioGX 
XfreeTM COVID-19 Direct RT-PCR assay and report to DMD/OHT7-OIR/OPEQ/CDRH 
(via email: CDRHEUA-Reporting@fda.hhs.gov) and BioGX, Inc. (via email: 
covid19@biogx.com) any suspected occurrence of false positive or false negative 
results and significant deviations from the established performance 
characteristics of the BioGX XfreeTM COVID-19 Direct RT-PCR assay of which they 
become aware.  

f) All laboratory personnel using the BioGX XfreeTM COVID-19 Direct RT-PCR assay 
must be appropriately trained in RT-PCR techniques and use appropriate 
laboratory and personal protective equipment when handling this kit, and use the 
BioGX XfreeTM COVID-19 Direct RT-PCR assay in accordance with the authorized 
labeling.  

g) BioGX, Inc. authorized distributors, and authorized laboratories using the BioGX 
XfreeTM COVID-19 Direct RT-PCR assay must ensure that any records associated 
with this EUA are maintained until otherwise notified by FDA. Such records will be 
made available to FDA for inspection upon request.  

 
1. The letter of authorization refers to, “Laboratories certified under the Clinical Laboratory Improvement 

Amendments of 1988(CLIA), 42U.S.C. §263a, that meet requirements to perform high complexity tests” 
as “authorized laboratories.” 

 

PERFORMANCE CHARACTERISTICS 

Analytical Sensitivity - Direct Patient Sample 
Limit of Detection (LoD) was determined by serially diluting quantified inactivated SARS-
CoV-2 (USA-WA1/2020; Zeptometrix catalog number NATSARS(CoV2)-ST) into negative 
NP swabs samples in Copan UTMⓇ/VTM, Saline, and Copan ESwabTM transport media. 
The LoD for contrived samples in saline, Copan ESwabTM, or Copan UTMⓇ/VTM was then 
confirmed by testing additional replicates (n=20) of inactivated SARS-CoV-2 virus. LoD 
confirmation was performed using the following real-time PCR platforms: Applied 
Biosystems QuantStudioTM 5, Applied Biosystems 7500 Fast Dx, Bio-Rad CFX96 TouchTM 
and Bio-Rad CFX384 TouchTM. The LoD for the assay using direct patient samples on the 
validated platforms ranged from 1,000 - 3,000 copies/mL (Table 3). 
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Table 3. LoD confirmation -Direct Patient Sample 

 
Instrument 

 
Transport Media 

 
Concentration 
[Copies/ mL] 

N1-gene RNase P IAC 
Agreement with 
Expected Result  

(% Positive) 
Mean Ct Mean Ct Mean Ct 

QuantStudioTM 5 

UTMⓇ/VTM 1000 19/20 (95%) 35.1 30.0 24.1 

Saline 1000 19/20 (95%) 34.2 31.4 24.4 

ESwabTM 3000 20/20 (100%) 34.1 29.2 25.4 

7500 Fast Dx  

UTMⓇ/VTM 1000 20/20 (100%) 34.6 30.6 26.4 

Saline 1000 20/20 (100%) 35.3 30.8 26.2 

ESwabTM 2000 20/20 (100%) 34.6 28.8 28.1 

CFX96 TouchTM  

UTMⓇ/VTM 1500 19/20 (95%) 36.4 30.4 27.4 

Saline 1500 20/20 (100%) 35.6 33.2 27.9 

ESwabTM 1500 19/20 (95%) 35.9 30.1 28.3 

CFX384 TouchTM 

UTMⓇ/VTM 1000 19/20 (95%) 36.3 31.2 27.2 

Saline  2000 20/20 (100%) 36.6 32.9 27.5 

ESwabTM  3000 20/20 (100%) 36.1 28.6 29.0 

 

Analytical Sensitivity - Extracted Patient Sample 
Limit of Detection (LoD) was determined by serially diluting quantified inactivated SARS-
CoV-2 (USA-WA1/2020; Zeptometrix catalog number NATSARS(CoV2)-ST) into negative 
NP swab samples in saline, Copan ESwabTM, or Copan UTMⓇ/VTM, which were then 
extracted with the Qiagen QIAamp Viral RNA Mini Kit as described above. The LoD for 
contrived samples in saline, Copan ESwabTM, or Copan UTMⓇ/VTM was then confirmed 
by testing additional replicates (n=20) of inactivated SARS-CoV-2 virus. LoD confirmation 
was performed using the following real-time PCR platforms: Applied Biosystems 
QuantStudioTM 5, Applied Biosystems 7500 Fast Dx, Bio-Rad CFX96 TouchTM and Bio-Rad 
CFX384 TouchTM. The LoD for the assay using extracted patient samples on the validated 
platforms ranged from 125 - 500 copies/mL (Table 4). 
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Table 4.  LoD confirmation – Extracted Patient Sample 

 
Instrument 

 
Transport Media 

 
Concentration 
[Copies/ mL] 

N1-gene RNase P IAC 
Agreement with 
Expected Result  

(% Positive) 
Mean Ct Mean Ct Mean Ct 

QuantStudioTM 5 

UTMⓇ/VTM 250 20/20 (100%) 33.9 25.5 23.5 
Saline 250 20/20 (100%) 34.6 29.3 23.5 

ESwabTM 500 19/20 (95%) 35.2 28.2 23.5 

7500 Fast Dx  

UTMⓇ/VTM 125 19/20 (95%) 35.2 28.4 26.1 

Saline 250 19/20 (95%) 34.7 29.2 26.1 

ESwabTM 250 19/20 (95%) 35.3 27.1 26.0 

CFX96 TouchTM 

UTMⓇ/VTM  250 20/20 (100%) 35.8 25.7 26.7 

Saline  250 20/20 (100%) 36.0 29.5 26.9 

ESwabTM  250 19/20 (95%) 36.3 27.1 26.8 

CFX384 TouchTM 

UTMⓇ/VTM 500 20/20 (200%) 36.7 26.9 26.5 

Saline  500 20/20 (100%) 36.5 29.6 26.4 

ESwabTM  500 20/20 (100%) 36.9 29.5 26.6 

*Qiagen Viral RNA Mini extraction kit used according to manufacturer recommendations (i.e. 140µL sample processed 
and eluted in 50µL). 

 

Inclusivity (in-silico) 
The XfreeTM COVID-19 assay primer and probe sequences are identical to the FDA EUA 
authorized CDC 2019-nCoV Real-Time RT-PCR Diagnostic Panel. CDC conducted the in 
silico inclusivity analysis. The data from this analysis is available in the CDC 2019-nCoV 
Real-Time RT-PCR Diagnostic Panel (CDC) Instructions For Use document, to which the 
CDC has granted a broad right of reference.  
 
An additional in silico analysis assessing the impact of the recently emerged SARS-CoV-2 
variants on target detection by BioGX showed that none of the observed mutations would 
be expected to interfere with N gene detection. 
 

Cross-Reactivity (Analytical Specificity) 
The XfreeTM COVID-19 assay primer and probe sequences are identical to the FDA EUA 
authorized CDC 2019-nCoV Real-Time RT-PCR Diagnostic Panel. CDC conducted the in 
silico cross-reactivity analysis. The data from this analysis is available in the CDC 2019-
nCoV Real-Time RT-PCR Diagnostic Panel (CDC) Instructions For Use document, to which 
the CDC has granted a broad right of reference. 
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Interfering Substances 
An interfering substances study was conducted to evaluate the potential of endogenous 
substances to cause both false positive and false negative results with the XfreeTM COVID-
19 assay when using the direct workflow. 
 
For this study, potential interfering substances were spiked into pooled Copan UTMⓇ 
negative nasopharyngeal swab samples containing no viral RNA or SARS-CoV-2 (USA-
WA1/2020; Zeptometrix catalog number NATSARS(CoV2)-ST) at approximately 5X LoD 
(5,000 copies/mL). Table 6 summarizes the results obtained from negative (SARS-CoV-2 
Negative NP) and positive (SARS-CoV-2 Positive NP) replicate runs (n=3) that were 
conducted for each substance. All runs were conducted following the direct sample 
workflow and analyzed with the both the Applied Biosystems QuantStudioTM 5 and Bio-
Rad CFX96 TouchTM. All samples yielded the expected results, indicating an absence of 
interference with the tested substances.  
 
 

Table 6. Analysis of interfering substances.   

Potential Interfering substance Final concentration 
(in sample)  

Agreement with expected results 

QuantStudioTM 5 CFX96 TouchTM  

SARS-
CoV-2 

Positive 
NP  

SARS-
CoV-2 

Negative 
NP 

SARS-
CoV-2 

Positive 
NP  

SARS-
CoV-2 

Negative 
NP 

None N/A 100% 100% 100% 100% 

Mucin (bovine submaxillary gland, type 
I-S) 2.5 mg/mL 100% 100% 100% 100% 

Mucin (bovine submaxillary gland, type 
I-S) 1.25 mg/mL 100% 100% 100% 100% 

Nasacort 10% v/v 100% 100% 100% 100% 

NeilMed NasoGEL 1.25% w/v 100% 100% 100% 100% 
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Similasan Nasal Allergy ReliefTM 15% v/v 100% 100% 100% 100% 

Saline Nasal Spray 15% v/v 100% 100% 100% 100% 

Act dry mouth lozenges 0.04 g/mL 100% 100% 100% 100% 

Chloraseptic® Spray 10% v/v 100% 100% 100% 100% 

Cepacol Extra Strength Cherry 
Lozenges 

0.046 g/mL  
(0.15mg/mL Benzocaine) 100% 100% 100% 100% 

Chloraseptic Lozenges 0.071 g/mL  
(0.12mg/mL Benzocaine) 100% 100% 100% 100% 

Halls Cough drops  0.062 g/mL  
(0.15 mg/mL Menthol) 100% 100% 100% 100% 

Nature’s Bounty® Zinc (50mg) 10µg/mL 100% 100% 100% 100% 

Nyquil  10% v/v 100% 100% 100% 100% 

Robitussin 10% v/v 100% 100% 100% 100% 

Flonase 5% v/v 100% 100% 100% 100% 

Ethanol 5% v/v 100% 100% 100% 100% 

ORIGINAL LISTERINE® Mouthwash  5% v/v 100% 100% 100% 100% 

Colgate Toothpaste Original 1% v/v 100% 100% 100% 100% 

Mupirocin Ointment (Bactroban) 5 mg/mL 100% 100% 100% 100% 

Tobramycin (Antibiotic) 100 ng/mL 100% 100% 100% 100% 

Oseltamivir (Tamiflu API) 3.3 mg/mL 100% 100% 100% 100% 

https://www.vitacost.com/similasan-1
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Emergen-C Vitamin C Drink - Super 
Orange 10% v/v 100% 100% 100% 100% 

Petroleum jelly (Vaseline) 1% w/v 100% 100% 100% 100% 

Tobacco 1% v/v 100% 100% 100% 100% 

 

Clinical Performance 
Positive percent agreement (PPA) and negative percent agreement (NPA) between the 
BioGX XfreeTM COVID-19 assay and a highly sensitive FDA EUA authorized RT-PCR 
comparator was determined using 60 individual SARS-CoV-2 positive and 35 individual 
SARS-CoV-2 negative clinical nasopharyngeal swab samples collected in UTM/VTM and 
collected by qualified healthcare professionals from individuals suspected of SARS-CoV-2 
infection. Samples were handled as described in the package insert of the collection 
device and stored frozen until use. 
 

Testing with Direct Patient Sample Addition 
The clinical samples were tested by direct sample addition (5 µL of clinical sample 
transferred directly into 15 µL of the BioGX XfreeTM COVID-19 mastermix). Clinical samples 
were analyzed on the QuantStudioTM 5 following the device instructions for use. The 
BioGX XfreeTM COVID-19 assay, when using the direct sample addition workflow achieved 
a PPA of 95% and an NPA of 100% when compared to the comparator method (Table 7).  
 

Testing with Extracted Patient Samples 
The clinical samples were also tested following the extracted patient sample workflow 
with the Qiagen QIAamp Viral RNA Mini Kit following the manufacturer’s 
recommendations, where 140 µL of clinical sample were extracted and then eluted with 
50 µL RNase-free water. The eluted nucleic acid template (5 µL) was added to 10 µL of 
the BioGX XfreeTM master mix. Positive clinical patient samples (n=60) and negative 
clinical patient samples (n=35) yielded a PPA and NPA of 100% and 94.29%, respectively, 
when analyzed on the QuantStudioTM 5 (Table 8).  
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Table 7. Clinical performance of the BioGX XfreeTM COVID-19 direct sample addition workflow 

BioGX XfreeTM COVID-19 Assay  
(Direct Sample Addition) 

 

Comparator RT-PCR EUA 
Test 

Positive Negative 

Positive 
57 0 

Negative 
3* 35 

Positive Percent Agreement (95%CI)  95.0% (86.3-98.3%) 

Negative Percent Agreement (95%CI) 100.0% (90.1-100.0%) 

*The three direct samples with discordant results were identified as positive by the comparator method with Ct values 
between 37.6 & 40.5.   
 
 
 
 
 
Table 8. Clinical performance of the BioGX XfreeTM COVID-19 extracted sample workflow 

BioGX XfreeTM COVID-19 Assay  
(Extracted Sample Workflow) 

Comparator RT-PCR EUA 
Test 

Positive Negative 

Positive 60 2* 

Negative 0 33 

Positive Percent Agreement 100.0% (94.0-100.0%) 

Negative Percent Agreement 94.3% (81.4-98.4%) 

*The two samples that tested positive with the BioGX XfreeTM COVID-19assay and negative with the comparator method 
was tested with a third, highly sensitive RT-PCR EUA authorized test. Both samples tested positive with the second RT-
PCR EUA authorized test. 
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1500 1st Ave. North, Suite C123, Birmingham, AL, USA - Phone: +1.205.250.8055 - Fax: +1.205.449.8055   
www.biogx.com - covid19@biogx.com - Technical Support email: TS@biogx.com 

APPENDIX A: Applied Biosystems QuantStudioTM 5 Thermocycling 
Programing 

 
Direct Patient Sample (20 μL reaction volume) 
 
Please refer to the following steps for QuantStudioTM 5 manual programming specific 
for Direct Patient sample testing.  
 
1. Open the QuantStudio Design and Analysis Software v1.5.1 
2. Select the “Create New Experiment” option 
3. Within the properties tab, select the following properties to filter: 

a. Name: User defined or 500003XMPDirectQS5v2  
b. Instrument Type: QuantStudio 5 System 
c. Block Type: 96-Well 0.2 mL 
d. Experiment type: Standard Curve 
e. Chemistry: TaqMan Reagents 
f. Run mode: Standard 

4. Run Method (Method Tab)  
a. Change the Reaction Volume to 20.0 μL 
b. Temperature of the enabled heated cover will remain at 105.0 °C 
c. Within the “PCR Stage “ section of the thermocycling parameters, an 

additional step will need to be added by bringing the mouse pointer 
above “Step 2” will allow  the “+” and “-” buttons to become visible. 

d. Click the “+”  button to add “Step 3” to the “PCR Stage”. 
e. Going back to the first hold stage enter the following parameters (Table 

A1): 
i. Hold Stage: Step 1 

1. 1.6 ramp rate 
2. 46°C 
3. 20 minutes 

ii. Hold Stage: Step 2 
1. 1.6 ramp rate 
2. 95°C 
3. 5 minutes 

iii. PCR Stage: Step 1 
1. 1.6 ramp rate 
2. 95°C 
3. 3 seconds 

  

http://www.biogx.com/
mailto:covid19@biogx.com
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iv. PCR Stage: Step 2 
1. 1.6 ramp rate 
2. 62°C 
3. 20 seconds 
4. Scanning is turned ON by clicking the camera icon (dark blue 
when ON).  

v. PCR Stage: Step 3 
1. 1.6 ramp rate 
2. 70°C 
3. 5 seconds 
4. Scanning is turned OFF by clicking the camera icon (light  
    blue when OFF).  

vi. Number of cycles set to 40 (located at the bottom of the “PCR Stage” 
section).  

 
Table A1. QuantStudioTM 5 thermocycling summary - Direct Patient Sample. 

PCR Cycle Summary 

 Hold Stage PCR Stage 

Conditions Step 1 Step 2 Step 1 Step 2  Step 3 

Ramp Rate (°C/s) 1.6 1.6 1.6 1.6 1.6 

Temperature (°C/s) 46 95 95 62 70 

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05 

Detection  OFF  OFF OFF  ON OFF  

No. of PCR Cycles  HOLD HOLD  40 

 
 
5. Plate Setup (Plate Tab) 

a. Under the “Plate Attribute” section of the Quick Setup tab, change the 
Passive Reference to “NONE”. 

b. On the left side of the screen (next to Quick Setup), choose “Advanced 
Setup”. 

c. In the “Targets” section, click on the “Add” box and add two targets for a 
total of three. Rename Target1 as “RNaseP”. 

d. Click the associated reporter box below the Reporter tab and, from the 
drop down menu, choose “FAM”. 
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e. Click on the “Target 2” box and change the name to “N1”. 
f. Click the associated reporter box below the Reporter tab and, from the 

drop down menu, choose “ROX”. 
g. Click on the “Target 3” box and change the name to “IAC”.  
h. Click the associated reporter box below the Reporter tab and, from the 

drop down menu, choose “Cy5” 
i. Ensure that the “Quencher” tab for all three targets is set to “None”.  
j. Highlight all the wells that you intend to use and ensure that the boxes 

besides the three targets are selected and in the task select “U” for 
unknown. This should populate the plate on the right side of the screen 
with each target.  

k. To name your wells by sample name, select the appropriate well on the 
right side of the screen. Under the “Samples” tab on the left side, click on 
the current sample name and rename to whatever is desired for the 
experiment. Check the box besides the sample name: the names will 
populate on the right side.  

l. To add additional sample names, click “Add” on the samples tab and 
repeat the instructions above. 

m. Click on the “Results” tab on the top of the screen 
6. Threshold Setup (Results Tab) 

a. Navigate to the “Results” tab and select the settings wheel besides 
“Analyze” in the upper right corner.  

b. Click on target “N1” and uncheck the “Ct Settings to Use: Default 
Settings” box directly to the right. Then uncheck the “Automatic 
Threshold” box: set the threshold to 10,000. 

c. Click on target “RNaseP” and uncheck the “Ct Settings to Use: Default 
Settings” box directly to the right. Then uncheck the “Automatic 
Threshold” box: set the threshold to 25,000. 

d. Click on target “IAC” and uncheck the “Ct Settings to Use: Default 
Settings” box directly to the right. Then uncheck the “Automatic 
Threshold” box: set the threshold to 5,000. 

e. Click “Apply” in the bottom right corner.  
7. Save File  

a. Navigate to the “File” tab and choose “Save As”. Name the file 
‘500003XMPDirectQS5v2’ and ensure it is saved as an *.edt file.  

8. Run File 
a. Select “File” then ”Open”.  
b. Select your chosen *.edt file.  
c. Navigate to the “Run” tab, and click the dropdown arrow next to   

“Start Run”. Ensure the name of the instrument is your preferred 
instrument. You will be prompted to enter a name for the run.  

d. Insert the desired run name and click “Start Run”.  
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Applied Biosystems QuantStudioTM 5 - Thermocycling Programing 
 
Extracted Patient Sample (15 μL reaction volume) 
 
Please refer to the following steps for QuantStudioTM 5 manual programming specific for 
Extracted Patient sample testing.    
 
1. Open the QuantStudio Design and Analysis Software v1.5.1 
 
2. Select the “Create New Experiment” option 
 
3. Within the properties tab, select the following properties to filter: 

a. Name: User defined or 500003XMPExtractQS5v2  
b. Instrument Type: QuantStudio 5 System 
c. Block Type: 96-Well 0.2 mL 
d. Experiment type: Standard Curve 
e. Chemistry: TaqMan Reagents 
f. Run mode: Standard 

 
4. Run Method (Method Tab)  

a. Change the Reaction Volume to 15.0 μL 
b. Temperature of the enabled heated cover will remain at 105.0 °C 
c. Within the “PCR Stage “ section of the thermocycling parameters, an additional 

step will need to be added by bringing the mouse pointer above “Step 2” will 
allow  the “+” and “-” buttons to become visible. 

d. Click the “+”  button to add “Step 3” to the “PCR Stage”. 
e. Going back to the first hold stage enter the following parameters (Table A1): 

i. Hold Stage: Step 1 
1. 1.6 ramp rate 
2. 46°C 
3. 20 minutes 

ii. Hold Stage: Step 2 
1. 1.6 ramp rate 
2. 95°C 
3. 5 minutes 

iii. PCR Stage: Step 1 
1. 1.6 ramp rate 
2. 95°C 
3. 3 seconds 

iv. PCR Stage: Step 2 
1. 1.6 ramp rate 
2. 62°C 
3. 20 seconds 
4. Scanning is turned ON by clicking the camera icon (dark blue when 
ON).  

v. PCR Stage: Step 3 
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1. 1.6 ramp rate 
2. 70°C 
3. 5 seconds 
4. Scanning is turned OFF by clicking the camera icon (light  
    blue when OFF). 

vi. Ensure the number of cycles is set to 40 (located at the bottom  
     border of the PCR Stage).  

 
5. Plate Setup (Plate Tab) 

a. Under the “Plate Attribute” section of the Quick Setup tab, change the Passive 
Reference to “NONE”. 

b. On the left side of the screen (next to Quick Setup), choose “Advanced Setup”. 
c. In the “Targets” section, click on the “Add” box and add two targets for a total 

of three. Rename Target1 as “RNaseP”. 
d. Click the associated reporter box below the Reporter tab and, from the drop 

down menu, choose “FAM”. 
e. Click on the “Target 2” box and change the name to “N1”. 
f. Click the associated reporter box below the Reporter tab and, from the drop 

down menu, choose “ROX”. 
g. Click on the “Target 3” box and change the name to “IAC”.  
h. Click the associated reporter box below the Reporter tab and, from the drop 

down menu, choose “Cy5” 
i. Ensure that the “Quencher” tab for all three targets is set to “None”.  
j. Highlight all the wells that you intend to use and ensure that the boxes besides 

the three targets are selected. In the “Task” section select “U” for unknown. 
This should populate the plate on the right side of the screen with each target.  

k. To name your wells by sample name, select the appropriate well on the right 
side of the screen. Under the “Samples” tab on the left side, click on the current 
sample name and rename to whatever is desired for the experiment. Check the 
box besides the sample name: the names will populate on the right side.  

l. To add additional sample names, click “Add” on the samples tab and repeat the 
instructions above. 

m. Click on the “Results” tab on the top of the screen 
 

6. Threshold Setup (Results Tab) 
a. Navigate to the “Results” tab and select the settings wheel besides “Analyze” in 

the upper right corner.  
b. Click on target “N1” and uncheck the “Ct Settings to Use: Default Settings” box 

directly to the right. Then uncheck the “Automatic Threshold” box: set the 
threshold to 10,000. 

c. Click on target “RNaseP” and uncheck the “Ct Settings to Use: Default Settings” 
box directly to the right. Then uncheck the “Automatic Threshold” box: set the 
threshold to 25,000. 

d. Click on target “IAC” and uncheck the “Ct Settings to Use: Default Settings” box 
directly to the right. Then uncheck the “Automatic Threshold” box: set the 
threshold to 5,000. 

e. Click “Apply” in the bottom right corner.  
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7. Save File  

a. Navigate to the “File” tab and choose “Save As”. Name the file 
‘500003XMPExtractQS5v2’ and ensure it is saved as an *.edt file.  

8. Run File 
a. Select “File” then ”Open”.  
b. Select your chosen *.edt file.  
c. Navigate to the “Run” tab, and click the dropdown arrow next to   

“Start Run”. Ensure the name of the instrument is your preferred instrument. 
You will be prompted to enter a name for the run.  

d. Insert the desired run name and click “Start Run”.  
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APPENDIX B: Applied Biosystems 7500 Fast Dx - Thermocycling 
Programing 

 
Direct Patient Sample (20 μL reaction volume) 
Please refer to the following steps for Applied Biosystems 7500 Fast Dx manual programming 
specific for Direct Patient sample testing.  
 

1. Open the Applied Biosystems 7500 Fast Dx software v1.4.1 
2. Go to the “Tools” tab and navigate to “Detector Manager” 

a. Click on the “File” dropdown and select “New”. 
b. Name the target as “N1” 

i. Set the reporter dye to “ROX” 
ii. Set the quencher dye to none 
iii. Click Apply 

c. Name the target as “RNaseP” 
i. Set the reporter dye to “FAM” 
ii. Set the quencher dye to “None” 
iii. Click Apply 

d. Name the target as “IAC” 
i. Set the reporter dye to “Cy5” 
ii. Set the quencher dye to “None” 
iii. Click Apply 

3. Click the “File” tab and select “New” 
4. On the “Define document” Pop-Up: 

a. Assay: Standard Curve (Absolute Quantification) 
b. Container: 96 Well Clear 
c. Template: Blank Document 
d. Run Mode: Fast 7500 
e. Operator: Select the operator you wish to run the assay with 
f. Plate Name: Select your desired name for the experiment file  
g. Click “Next” 

5. Select the previously created detectors from the library: N1, RNaseP, IAC and click add. 
6. Set the Passive Reference to “None” 
7. Click “next”. Select all the wells and assign the targets to them. 
8. Select Finish. 
9. Navigate to the Instrument tab. 

a. Change the Sample Volume to 20.0 μL 
b. Click the “Add Hold” button until you have two hold steps. Set the number of 

repetitions to 1.  
c. Click the “Add Step” button until you have three PCR cycling steps. Set the 

number of repetitions for this stage to 40.  
d. Going back to the first hold stage enter, the following parameters (Table B1): 

i. Hold Stage: Step 1 
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1. Auto ramp rate 
2. 46°C 
3. 20 minutes 

ii. Hold Stage: Step 2 
1. Auto ramp rate 
2. 95°C 
3. 5 minutes 

iii. PCR Stage: Step 1 
1. Auto ramp rate 
2. 95°C 
3. 3 seconds 

iv. PCR Stage: Step 2 
1. Auto ramp rate 
2. 62°C 
3. 24 seconds.  

v. PCR Stage: Step 3 
1. Auto ramp rate 
2. 70°C  
3. 5 seconds  

vi. Under settings, select the following: 
1. Sample Volume: 20 
2. Run Mode: Fast 7500 
3. Data Calculation: Stage 3, step 2 

e. Select the “Analysis” tab and click “Analysis settings”. 
i. Select N1’s target settings by clicking on the detector dropdown. 

1. Select “Manual CT” and set the threshold to 50,000 
2. Select “Manual Baseline” and set the start cycle to 3 and the 

end to 10.  
3. Click apply 

ii. Select RNaseP 
1. Select Manual CT and set the threshold to 100,000 
2. Select “Manual Baseline” and set the start cycle to 3 and the 

end to 15 
3. Click apply 

iii. Select IAC 
1. Select Manual CT and set the threshold to 100,000 
2. Select “Manual Baseline” and set the start cycle to 3 and the 

end to 20 
3. Click “Apply”, then select “OK”. 

f. Select File -> Save. Set your desired name and your template is saved.  
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Table B1. Applied Biosystems 7500 thermocycling summary - Direct Patient Sample. 

PCR Cycle Summary 

 Hold Stage PCR Stage 

Conditions Step 1 Step 2 Step 1 Step 2  Step 3 

Ramp Rate (°C/s) Auto Auto Auto Auto Auto 

Temperature (°C/s) 46 95 95 62 70 

Duration (Min:sec) 20:00 5:00 0:03 0:24 0:05 

Detection  OFF  OFF OFF  ON OFF  

No. of PCR Cycles  HOLD HOLD  40 

 
 
Applied Biosystems 7500 Fast Dx- Thermocycling Programing 
 
Extracted Patient Sample (15 μL reaction volume) 
Please refer to the following steps for Applied Biosystems 7500 Fast Dx manual programming 
specific for Extracted patient sample testing.  
 

1. Open the Applied Biosystems 7500 Fast Dx software v1.4.1 
2. Go to the “Tools” tab and navigate to “Detector Manager” 

a. Click on the “File” dropdown and select “New”. 
b. Name the target as “N1” 

i. Set the reporter dye to “ROX” 
ii. Set the quencher dye to none 
iii. Click Apply 

c. Name the target as “RNaseP” 
i. Set the reporter dye to “FAM” 
ii. Set the quencher dye to “None” 
iii. Click Apply 

d. Name the target as “IAC” 
i. Set the reporter dye to “Cy5” 
ii. Set the quencher dye to “None” 
iii. Click Apply 

3. Click the “File” tab and select “New” 
4. On the “Define document” Pop-Up: 

a. Assay: Standard Curve (Absolute Quantification) 
b. Container: 96 Well Clear 
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c. Template: Blank Document 
d. Run Mode: Fast 7500 
e. Operator: Select the operator you wish to run the assay with 
f. Plate Name: Select your desired name for the experiment file  
g. Click “Next” 

5. Select the previously created detectors from the library: N1, RNaseP, IAC and click add. 
6. Set the Passive Reference to “None” 
7. Click “next”. Select all the wells and assign the targets to them. 
8. Select Finish. 
9. Navigate to the Instrument tab. 

a. Change the Sample Volume to 15.0 μL 
b. Click the “Add Hold” button until you have two hold steps. Set the number of 

repetitions to 1.  
c. Click the “Add Step” button until you have three PCR cycling steps. Set the 

number of repetitions for this stage to 40.  
d. Going back to the first hold stage enter, the following parameters (Table B1): 

i. Hold Stage: Step 1 
1. Auto ramp rate 
2. 46°C 
3. 20 minutes 

ii. Hold Stage: Step 2 
1. Auto ramp rate 
2. 95°C 
3. 5 minutes 

iii. PCR Stage: Step 1 
1. Auto ramp rate 
2. 95°C 
3. 3 seconds 

iv. PCR Stage: Step 2 
1. Auto ramp rate 
2. 62°C 
3. 24 seconds.  

v. PCR Stage: Step 3 
1. Auto ramp rate 
2. 70°C  
3. 5 seconds  

vi. Under settings, select the following: 
1. Sample Volume: 20 
2. Run Mode: Fast 7500 
3. Data Calculation: Stage 3, step 2 

e. Select the “Analysis” tab and click “Analysis settings”. 
i. Select N1’s target settings by clicking on the detector dropdown. 

1. Select “Manual CT” and set the threshold to 50,000 
2. Select “Manual Baseline” and set the start cycle to 3 and the 

end to 10.  
3. Click apply 

ii. Select RNaseP 
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1. Select Manual CT and set the threshold to 100,000 
2. Select “Manual Baseline” and set the start cycle to 3 and the 

end to 15 
3. Click apply 

iii. Select IAC 
1. Select Manual CT and set the threshold to 100,000 
2. Select “Manual Baseline” and set the start cycle to 3 and the 

end to 20 
3. Click “Apply”, then select “OK”. 

f. Select File -> Save. Set your desired name and your template is saved.  
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APPENDIX C: Bio-Rad CFX96 TouchTM  - Thermocycling Programing 
 
Direct Patient Sample (20 μL reaction volume) 
Please refer to the following steps for CFX96 TouchTM manual programming specific for Direct 
Patient sample testing.  
 
1. Launch the CFX Maestro software. 
 
2. Select “File”, then choose “New” and select “Protocol” 
 
3. Program thermocycling conditions in the Protocol Editor 

a. Set Sample Volume to 20 μL 
b. Click “Insert Step” to add a total of five total steps and program as follows (Table C1): 
c. Step 1  

i. Temp: 46°C 
ii. Time: 20:00 

d. Step 2  
i. Temp: 95°C 
ii. Time: 5:00 

 e. Step 3  
i. Temp: 95°C 
ii. Time: 0:03 

 f. Step 4  
i. Temp: 62°C 
ii. Time: 0:20 
iii. Click “Add Plate Read to Step”. Also, ensure this is the only step containing a 
plate read 

 g. Step 5 
i. Temp: 70°C 
ii. Time: 0:05 

h. Step 6 
i. Click to highlight “GOTO” and enter “3” to indicate thermocycling  
   includes Step 3, Step 4 and Step 5.  
ii. At “GOTO 3”, confirm “39 more times” is programmed for a total of 40 cycles. 

 I. Save the new cycling conditions as protocol for future use 
i. At the upper left of the screen select the Save button 
ii. Save in the ExpressLoad folder 
iii. Name the file ‘500003XMPDirectCFX96v2’ 
iv. Save as type ‘Protocol File (*.prcl)’ 
v. Select Save 
vi. Click Ok in the protocol editor window 
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Table C1. CFX96 TouchTM thermocycling summary - Direct Patient Sample. 

PCR Cycle Summary 

 Hold Stage PCR Stage 

Conditions Step 1 Step 2 Step 1 Step 2  Step 3 

Temperature (°C/s) 46 95 95 62 70 

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05 

Detection  OFF OFF  OFF  ON OFF  

No. of PCR Cycles  HOLD HOLD  40 

 
4. Define the plate setup 

a. Select “File” then choose “New” and select “Plate” 
b. In the Plate Editor, click settings and ensure your settings are as follows 
 i. Plate Size: 96 wells 
 ii. Plate Type: BR White OR BR Clear (BioGX recommends BR White) 
c. Highlight all wells and choose “Select Fluorophores” 

i. Uncheck all currently selected wells and check ONLY the following: FAM, Cal 
Red 610, Quasar 670 

 d. For “Sample Type” select “Unknown” 
e. Check the boxes besides all three of your selected fluorophores. Change the  

target name as follows: 
 i. FAM: RNaseP 
 ii. Cal Red 610: N1 
 iii. Quasar 670: IAC 
f. Save the new plate setup for future use 

i. At the upper left of the screen select ”File” then select “Save” 
iii. Name the file ‘500003XMPDirect_plateCFX96v2’ 
iv. Save as type ‘Plate File (*.pltd)’ 
v. Select Save 
vi. Click Ok in the Plate Editor window 

g. Saving Protocol 
i. Select “File” then “Open”  
ii. Select “Protocol” then open your saved protocol.  
ii. Ensure the PCR steps are correct and click “OK” 
iii. Click the “Plate” tab and choose “Select Existing”. Choose the   
    plate that was saved.  
iv. Add any desired notes and click on the “Start Run” tab.  
v. Save the run with the desired name 

h. Assigning a sample name to well positions 
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Once the run has begun, reaction wells can be assigned with a unique sample 
name as follows: 
i. Navigate to “Real Time Status”  
ii. On the top-middle section of the screen, click “Plate Set-Up”  
    followed by “View/Edit Plate”.  
iii.Click “Spreadsheet View/Importer” on the upper right quadrant of  
    the screen. Wells can be named with unique identifiers for  
    Sample Name, Sample Type, etc.  

5. When CFX96 TouchTM run is completed, threshold setting update will need to be completed 
as follows: 

a. Open the “Data Analysis” window for your specific run 
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel and 

Quasar 670-channel and be sure “FAM” is checked (Note: Threshold 
adjustments can be performed only in single threshold mode, be sure only one 
dye is selected) 
i.Navigate to “Settings” and select “Baseline Threshold” 
ii.At the bottom of the popup window under “single threshold”, select “User 

Defined” and enter “500”  
iii.Click “OK” and the threshold for FAM will apply to the experiment. 

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel and 
Quasar 670-channel and be sure “CalRed 610” is checked (Note: Threshold 
adjustments can be performed only in single threshold mode, be sure only one 
dye is selected) 
i.Navigate to “Settings” and select “Baseline Threshold” 
ii.At the bottom of the popup window under “single threshold”, select “User 

Defined” and enter “500”  
iii.Click “OK” and the threshold for CalRed 610 will apply to the experiment 

d. To apply threshold settings for Quasar 670-channel, uncheck FAM-channel and 
CalRed 610-channel and be sure “Quasar 670” is checked (Note: Threshold 
adjustments can be performed only in single threshold mode, be sure only one 
dye is selected) 
i.Navigate to “Settings” and select “Baseline Threshold” 
ii.At the bottom of the popup window under “single threshold”, select “User 

Defined” and enter “500”  
iii.Click “OK” and the threshold for Quasar 670 will apply to the experiment 

6. Refer to Table 2 for result interpretation. 
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Bio-Rad CFX96 TouchTM  - Thermocycling Programing 
 
Extracted Patient Sample (15 μL reaction volume) 
Please refer to the following steps for CFX96 TouchTM manual programming specific for 
Extracted Patient sample testing.    
 
1. Launch the CFX Maestro software. 
 
2. Choose “File”, then choose “New” and select “Protocol” 
 
3. Program thermocycling conditions in the Protocol Editor 

a. Set Sample Volume to 15 μL 
b. Click “Insert Step” to add a total of five total steps and program as follows (Table C1): 
c. Step 1  

i. Temp: 46°C 
ii. Time: 20:00 

d. Step 2  
i. Temp: 95°C 
ii. Time: 5:00 

 e. Step 3  
i. Temp: 95°C 
ii. Time: 0:03 

 f. Step 4  
i. Temp: 62°C 
ii. Time: 0:20 
iii. Click “Add Plate Read to Step”. Also, ensure this is the only step containing a 
plate read 

 g. Step 5 
i. Temp: 70°C 
ii. Time: 0:05 

h. Step 6 
i. Click to highlight “GOTO” and enter “3” to indicate thermocycling  
   includes Step 3, Step 4 and Step 5.  
ii. At “GOTO 3”, confirm “39 more times” is programmed for a total of 40 cycles. 

i. Save the new cycling conditions as a protocol for future use 
i. At the upper left of the screen select the Save button 
ii. Save in the ExpressLoad folder 
iii. Name the file ‘500003XMPExtractCFX96v2’ 
iv. Save as type ‘Protocol File (*.prcl)’ 
v.  Select Save 
vi. Click Ok in the protocol editor window 

4. Define the plate setup 
a. Select “File” then choose “New” and select “Plate” 
b. In the Plate Editor, click settings and ensure your settings are as follows 
 i. Plate Size: 96 wells 
 ii. Plate Type: BR White OR BR Clear (BioGX recommends BR White) 
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c. Highlight all wells and choose “Select Fluorophores” 
i. Uncheck all currently selected wells and check ONLY the following: FAM, Cal 
Red 610, Quasar 670 

 d. For “Sample Type” select “Unknown” 
e. Check the boxes besides all three of your selected fluorophores. Change the  

target name as follows: 
 i. FAM: RNaseP 
 ii. CalRed 610: N1 
 iii.: Quasar 670: IAC 
f. Save the new plate setup for future use 

i. At the upper left of the screen select ”File” then select “Save” 
iii. Name the file “500003XMPExtract_plateCFX96v2”.  
iv. Ensure it is saved in the “*.pltd” format 
v. Select Save 
vi. Click Ok in the Plate Editor window 

g. Saving Protocol 
i. Select “File” then “Open”  
ii. Select “Protocol” then open your saved protocol.  
ii. Ensure the PCR steps are correct and click “OK” 
iii. Click the “Plate” tab and choose “Select Existing”. Choose the   
    plate that was saved.  
iv. Add any desired notes and click on the “Start Run” tab.  
v. Save the run with the desired name  

h. Assigning a sample name to well positions 
Once the run has begun, reaction wells can be assigned with a unique sample 
name as follows: 
i. Navigate to “Real Time Status”  
ii. On the top-middle section of the screen, click “Plate Set-Up”  
    followed by “View/Edit Plate”.  
iii.Click “Spreadsheet View/Importer” on the upper right quadrant of  
    the screen. Wells can be named with unique identifiers for  
    Sample Name, Sample Type, etc.  

5. When CFX96 TouchTM run is completed, threshold setting update will need to be completed 
as follows: 

a. Open the “Data Analysis” window for your specific run 
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel and 

Quasar 670-channel and be sure “FAM” is checked (Note: Threshold 
adjustments can be performed only in single threshold mode, be sure only one 
dye is selected) 
i.Navigate to “Settings” and select “Baseline Threshold” 
ii.At the bottom of the popup window under “single threshold”, select “User 

Defined” and enter “500”  
iii.Click “OK” and the threshold for FAM will apply to the experiment. 

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel and 
Quasar 670-channel and be sure “CalRed 610” is checked (Note: Threshold 
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adjustments can be performed only in single threshold mode, be sure only one 
dye is selected) 
i.Navigate to “Settings” and select “Baseline Threshold” 
ii.At the bottom of the popup window under “single threshold”, select “User 

Defined” and enter “500”  
iii.Click “OK” and the threshold for CalRed 610 will apply to the experiment 

d. To apply threshold settings for Quasar 670-channel, uncheck FAM-channel and 
CalRed 610-channel and be sure “Quasar 670” is checked (Note: Threshold 
adjustments can be performed only in single threshold mode, be sure only one 
dye is selected) 
i.Navigate to “Settings” and select “Baseline Threshold” 
ii.At the bottom of the popup window under “single threshold”, select “User 

Defined” and enter “500”  
iii.Click “OK” and the threshold for Quasar 670 will apply to the experiment 

6. Refer to Table 2 for result interpretation. 
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APPENDIX D: Bio-Rad CFX384 TouchTM  - Thermocycling Programing 

 
Direct Patient Sample (20 μL reaction volume) 
Please refer to the following steps for CFX384 TouchTM manual programming specific for Direct 
Patient sample testing.  
 
1. Launch the CFX Maestro software. 
 
2. Select “File”, then choose “New” and select “Protocol” 
 
3. Program thermocycling conditions in the Protocol Editor 

a. Set Sample Volume to 20 μL 
b. Click “Insert Step” to add a total of five total steps and program as follows (Table D1): 
c. Step 1  

i. Temp: 46°C 
ii. Time: 20:00 

d. Step 2  
i. Temp: 95°C 
ii. Time: 5:00 

 e. Step 3  
i. Temp: 95°C 
ii. Time: 0:03 

 f. Step 4  
i. Temp: 62°C 
ii. Time: 0:20 
iii. Click “Add Plate Read to Step”. Also, ensure this is the only step containing a 
plate read 

 g. Step 5 
i. Temp: 70°C 
ii. Time: 0:05 

h. Step 6 
i. Click to highlight “GOTO” and enter “3” to indicate thermocycling  
   includes Step 3, Step 4 and Step 5.  
ii. At “GOTO 3”, confirm “39 more times” is programmed for a total of 40 cycles. 

 I. Save the new cycling conditions as protocol for future use 
i. At the upper left of the screen select the Save button 
ii. Save in the ExpressLoad folder 
iii. Name the file ‘500003XMPDirectCFX384’ 
iv. Save as type ‘Protocol File (*.prcl)’ 
v. Select Save 
vi. Click Ok in the protocol editor window 
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Table D1. CFX384 TouchTM thermocycling summary - Direct Patient Sample. 

PCR Cycle Summary 

 Hold Stage PCR Stage 

Conditions Step 1 Step 2 Step 1 Step 2  Step 3 

Temperature (°C/s) 46 95 95 62 70 

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05 

Detection  OFF OFF  OFF  ON OFF  

No. of PCR Cycles  HOLD HOLD  40 

 
4. Define the plate setup 

a. Select “File” then choose “New” and select “Plate” 
b. In the Plate Editor, click settings and ensure your settings are as follows 
 i. Plate Size: 384 well 
 ii. Plate Type: BR White OR BR Clear (BioGX recommends BR White) 
c. Highlight all wells and choose “Select Fluorophores” 

i. Uncheck all currently selected wells and check ONLY the following: FAM, Cal 
Red 610, Quasar 670 

 d. For “Sample Type” select “Unknown” 
e. Check the boxes besides all three of your selected fluorophores. Change the  

target name as follows: 
 i. FAM: RNaseP 
 ii. Cal Red 610: N1 
 iii. Quasar 670: IAC 
f. Save the new plate setup for future use 

i. At the upper left of the screen select ”File” then select “Save” 
iii. Name the file ‘500003XMPDirect_plateCFX384’ 
iv. Save as type ‘Plate File (*.pltd)’ 
v. Select Save 
vi. Click Ok in the Plate Editor window 

g. Saving Protocol 
i. Select “File” then “Open”  
ii. Select “Protocol” then open your saved protocol.  
ii. Ensure the PCR steps are correct and click “OK” 
iii. Click the “Plate” tab and choose “Select Existing”. Choose the   
    plate that was saved.  
iv. Add any desired notes and click on the “Start Run” tab.  
v. Save the run with the desired name 

h. Assigning a sample name to well positions 
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Once the run has begun, reaction wells can be assigned with a unique sample 
name as follows: 
i. Navigate to “Real Time Status”  
ii. On the top-middle section of the screen, click “Plate Set-Up”  
    followed by “View/Edit Plate”.  
iii.Click “Spreadsheet View/Importer” on the upper right quadrant of  
    the screen. Wells can be named with unique identifiers for  
    Sample Name, Sample Type, etc.  

5. When CFX96 TouchTM run is completed, threshold setting update will need to be completed 
as follows: 

a. Open the “Data Analysis” window for your specific run 
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel and 

Quasar 670-channel and be sure “FAM” is checked (Note: Threshold 
adjustments can be performed only in single threshold mode, be sure only one 
dye is selected) 
i.Navigate to “Settings” and select “Baseline Threshold” 
ii.At the bottom of the popup window under “single threshold”, select “User 

Defined” and enter “500”  
iii.Click “OK” and the threshold for FAM will apply to the experiment. 

d. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel and 
Quasar 670-channel and be sure “CalRed 610” is checked (Note: Threshold 
adjustments can be performed only in single threshold mode, be sure only one 
dye is selected) 
i.Navigate to “Settings” and select “Baseline Threshold” 
ii.At the bottom of the popup window under “single threshold”, select “User 

Defined” and enter “500”  
iii.Click “OK” and the threshold for CalRed 610 will apply to the experiment 

e. To apply threshold settings for Quasar 670-channel, uncheck FAM-channel and 
CalRed 610-channel and be sure “Quasar 670” is checked (Note: Threshold 
adjustments can be performed only in single threshold mode, be sure only one 
dye is selected) 
i.Navigate to “Settings” and select “Baseline Threshold” 
ii.At the bottom of the popup window under “single threshold”, select “User 

Defined” and enter “500”  
iii.Click “OK” and the threshold for Quasar 670 will apply to the experiment 

6. Refer to Table 2 for result interpretation. 
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Bio-Rad CFX384 TouchTM  - Thermocycling Programing 
 
Extracted Patient Sample (15 μL reaction volume) 
Please refer to the following steps for CFX384 TouchTM manual programming specific for 
Extracted Patient sample testing.    
 
1. Launch the CFX Maestro software. 
 
2. Choose “File”, then choose “New” and select “Protocol” 
 
3. Program thermocycling conditions in the Protocol Editor 

a. Set Sample Volume to 15 μL 
b. Click “Insert Step” to add a total of five total steps and program as follows (Table D1): 
c. Step 1  

i. Temp: 46°C 
ii. Time: 20:00 

d. Step 2  
i. Temp: 95°C 
ii. Time: 5:00 

 e. Step 3  
i. Temp: 95°C 
ii. Time: 0:03 

 f. Step 4  
i. Temp: 62°C 
ii. Time: 0:20 
iii. Click “Add Plate Read to Step”. Also, ensure this is the only step containing a 
plate read 

 g. Step 5 
i. Temp: 70°C 
ii. Time: 0:05 

h. Step 6 
i. Click to highlight “GOTO” and enter “3” to indicate thermocycling  
   includes Step 3, Step 4 and Step 5.  
ii. At “GOTO 3”, confirm “39 more times” is programmed for a total of 40 cycles. 

i. Save the new cycling conditions as a protocol for future use 
i. At the upper left of the screen select the Save button 
ii. Save in the ExpressLoad folder 
iii. Name the file ‘500003XMPExtractCFX384’ 
iv. Save as type ‘Protocol File (*.prcl)’ 
v.  Select Save 
vi. Click Ok in the protocol editor window 

4. Define the plate setup 
a. Select “File” then choose “New” and select “Plate” 
b. In the Plate Editor, click settings and ensure your settings are as follows 
 i. Plate Size: 384 well 
 ii. Plate Type: BR White OR BR Clear (BioGX recommends BR White) 
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c. Highlight all wells and choose “Select Fluorophores” 
i. Uncheck all currently selected wells and check ONLY the following: FAM, Cal 
Red 610, Quasar 670 

 d. For “Sample Type” select “Unknown” 
e. Check the boxes besides all three of your selected fluorophores. Change the  

target name as follows: 
 i. FAM: RNaseP 
 ii. CalRed 610: N1 
 iii.: Quasar 670: IAC 
f. Save the new plate setup for future use 

i. At the upper left of the screen select ”File” then select “Save” 
iii. Name the file “500003XMPExtract_plateCFX384”.  
iv. Ensure it is saved in the “*.pltd” format 
v. Select Save 
vi. Click Ok in the Plate Editor window 

g. Saving Protocol 
i. Select “File” then “Open”  
ii. Select “Protocol” then open your saved protocol.  
ii. Ensure the PCR steps are correct and click “OK” 
iii. Click the “Plate” tab and choose “Select Existing”. Choose the   
    plate that was saved.  
iv. Add any desired notes and click on the “Start Run” tab.  
v. Save the run with the desired name  

h. Assigning a sample name to well positions 
Once the run has begun, reaction wells can be assigned with a unique sample 
name as follows: 
i. Navigate to “Real Time Status”  
ii. On the top-middle section of the screen, click “Plate Set-Up”  
    followed by “View/Edit Plate”.  
iii.Click “Spreadsheet View/Importer” on the upper right quadrant of  
    the screen. Wells can be named with unique identifiers for  
    Sample Name, Sample Type, etc.  

5. When CFX96 TouchTM run is completed, threshold setting update will need to be completed 
as follows: 

a. Open the “Data Analysis” window for your specific run 
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel and 

Quasar 670-channel and be sure “FAM” is checked (Note: Threshold 
adjustments can be performed only in single threshold mode, be sure only one 
dye is selected) 
i.Navigate to “Settings” and select “Baseline Threshold” 
ii.At the bottom of the popup window under “single threshold”, select “User 

Defined” and enter “500”  
iii.Click “OK” and the threshold for FAM will apply to the experiment. 

d. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel and 
Quasar 670-channel and be sure “CalRed 610” is checked (Note: Threshold 
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adjustments can be performed only in single threshold mode, be sure only one 
dye is selected) 
i.Navigate to “Settings” and select “Baseline Threshold” 
ii.At the bottom of the popup window under “single threshold”, select “User 

Defined” and enter “500”  
iii.Click “OK” and the threshold for CalRed 610 will apply to the experiment 

e. To apply threshold settings for Quasar 670-channel, uncheck FAM-channel and 
CalRed 610-channel and be sure “Quasar 670” is checked (Note: Threshold 
adjustments can be performed only in single threshold mode, be sure only one 
dye is selected) 
i.Navigate to “Settings” and select “Baseline Threshold” 
ii.At the bottom of the popup window under “single threshold”, select “User 

Defined” and enter “500”  
iii.Click “OK” and the threshold for Quasar 670 will apply to the experiment 

6. Refer to Table 2 for result interpretation. 
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APPENDIX E: EUO LABELING 
 
 
For the Applied Biosystems QuantStudio 5, Bio-Rad CFX96 Touch and Bio-Rad CFX384 Touch 
PCR Instruments 
 
Please print the below label and place the label on the front panel of the instrument. If the 
instrument includes labeling indicating “For Research Use Only”, please cover with the below 
“Emergency Use Only” labeling. The instrument should retain this labeling throughout the EUA 
use of the BioGX XfreeTM COVID-19 Direct RT-PCR assay. 
 
---------------------------------------------------------------------------- 
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APPENDIX F REVISION HISTORY 
 

Version Date Description of Change 

Draft 04.1 
22 JUN 2021 Addition of Appendix E –EUO Label for platforms 

 
Accepted FDA text edit suggestions 

Draft 04 

 
 
 
14 JUN 2021 

FDA redline text suggestions accepted. 
 
Added Table of Contents section. 
 
Updated Materials Required but not provided section to include 
pipettes, pipette tips, centrifuge, and 1.5 mL tubes. 
 
Added FDA recommended additional warnings and precautions. 
 
Updated external positive control run frequency to one external 
positive control be included with each RT-PCR run of patient 
samples and external negative controls should be run with each 
extraction batch (as applicable) and each PCR run. 
 
Accepted FDA recommended clinical performance. 
 
Specimen collection, storage, and handling section added. 
 
Added information for customers on how to obtain EUO label for 
platforms 
 
Minor text edits and formatting  

Draft 03.1 26 MAR 2021 

Update number of reactions (tests) per tube to number of 
reactions (tests) per kit. Update Table 2 to simplify interpretation, 
Revision status updated to 03.1 from 03 
 
FDA Recommended Track Changes (28MAY2021)-Update 
“Preparation of BioGX External Controls” section, update Table. 1  
to simplify expected Ct values for N1 and IAC.  
 
FDA Recommended Track Changes (08JUN2021)- Update of 
storage of rehydrated master mix to indicate unused rehydrated 
master mix is to be discarded 
 
Update “Preparation of BioGX External Controls” section to 
include “Preparation of BioGX External Controls for Direct Sample 
Workflow” 
 
Update “Quality Control” section to include Zeptometrix SARS-
CoV-2 as alternative positive control 
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Update dilution protocol in “Preparation of BioGX External 
Controls” section 
 
 

03 10 FEB 2021 

Update fluorophore utilized for IAC detection, addition of 
nasopharyngeal wash/aspirates and nasal aspirate sample types, 
addition of Applied BioSystems 7500 Fast Dx and Bio-Rad CFX384 
Touch platforms, update BioGX Rehydration Water Part number to 
800-0035-12, update use of Qiagen Viral RNA Mini Kit, update 
comparator method (LineaTM COVID-19 assay), update clinical 
concordance study. Revision status updated to 02.4 from 03 

02.4 19 NOV 2020 
Correction of revision date, “Validation of this test has not been 
reviewed by FDA” paragraph moved to the end of the Intended Use 
statement on Page 2. Revision status updated to 02.4 from 02.3 

02.3 19 NOV 2020 
Intended Use statement on Page 2 updated to include “Validation 
of this test has not been reviewed by FDA” paragraph. Revision 
status updated to 02.3 from 02.2 

02.2 18 NOV 2020 

Update FDA EUA Review Status statement, Update “Limitations of 
the Procedure” section, update “Clinical Performance” section, 
update “Reference” section. Revision status updated to 02.2 from 
02.1 

02.1 12 NOV 2020 

Addition of FDA EUA Review Status, update positive control and 
patient result interpretation, update limit of detection table, 
update clinical performance. Revision status updated to 02.1 from 
02 

02 20 OCT 2020 
Correction of BioGX address, minor formatting changes, correction 
of references, correction of positive control use. Revision status 
updated to 02 from 01 

01 09 OCT 2020 Initial Release 
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SYMBOLS 
 

Symbol Meaning 

 
Catalog number 

 
In vitro diagnostic medical device 

 
Do not reuse 

 
Batch code 

 
Caution 

 
Consult instructions for use 

 
Manufacturer 

 
Contains sufficient for <n> tests 

 
Temperature limitation  

 
Keep dry 

 
Keep away from sunlight 

 
Expiration date 

 
Biological Risks 

 
Control 

  
 
 

 
1500 1st Ave. North, Suite C123, Birmingham, AL, USA 
Phone: +1.205.250.8055 
Fax: +1.205.449.8055 
www.biogx.com 
covid19@biogx.com 
Technical Support email: TS@biogx.com 
 

 

http://www.biogx.com/
mailto:covid19@biogx.com


500-003-XMP

8 ºC

2 ºC

STORAGE AND STABILITY
BioGX recommends long-term storage at 2-8°C. Product is stable when shipped for under 5 days at ambient
temperature.

Reagents have been tested to demonstrate optimal performance when stored properly at 2-8°C and consumed by
the expiration date on the kit label.

Avoid exposing the reagents (lyophilized or rehydrated) to direct sunlight or long-term ambient lighting.
Store unused rehydrated master mix up to 24 hours at 2-8°C, protected from light.

If pouch is opened by the user but lyophilized reagent is not rehydrated, avoid exposure of lyophilized reagent to
moisture and use the entire contents of the opened pouch within 1 month.

SAFE HANDLING
Use clean gloves when handling PCR reagents and buffer tubes.
Do not use reagent tubes if tube caps have been opened or damaged. Do not mix reagents from different
pouches and/or kits and/or lots.

Be advised, this is not the complete product IFU. Consult current version of Instructions For Use (IFU) and
download current version of Electronic User Defined Protocol (eUDP) prior to use. Current versions are available
at www.biogx.com OR by emailing info@biogx.com for an electronic version OR a free printed copy.

Current IFU version: 500-003-XMP Xfree™ COVID-19 Direct RT-PCR (US) Rev.Draft03.1
Current eUDP version:
ABI 7500 Fast Dx:
Direct: 500003XMPDirect7500Dx / 500003XMPDirect7500Dx.sdt
Extracted: 500003XMPExtract7500Dx / 500003XMPExtract7500Dx.sdt

Bio-Rad CFX96 Touch™:
Direct: 500003XMPDirect_plateCFX96v2.pltd / 500003XMPDirectCFX96v2 / 500003XMPDirectCFX96v2.prcl
Extracted: 500003XMPExtract_plateCFX96v2.pltd / 500003XMPExtractCFX96v2 / 500003XMPExtractCFX96v2.prcl

Bio-Rad CFX384 Touch™:
Direct: 500003XMPDirect_plateCFX384.pltd / 500003XMPDirectCFX384 / 500003XMPDirectCFX384.prcl
Extracted: 500003XMPExtract_plateCFX384.pltd / 500003XMPExtractCFX384 / 500003XMPExtractCFX384.prcl

QuantStudio™5:
Direct: 500003XMPDirectQS5v2.edt / 500003XMPDirectQS5v2
Extracted: 500003XMPExtractQS5v2.edt / 500003XMPExtractQS5v2

Download a free QR Code Scanner App.
with your mobile phone. Using the QR
Code App., take a picture of the QR
Code. The App. will automatically scan
the QR code to obtain current
versions of IFU and eUDP via the BioGX
website.

https://biogx.com/xfree/

SARS-CoV-2 (N1), RNase P,
IAC
Extraction-Free Direct RT-PCR - Multi-Platform

500-003-XMP PIC Rev.01-29June2021

1500 1st Ave. North, Suite C123, Birmingham, AL, USA
Phone: +1.205.250.8055 www.BioGX.com

For use under the Emergency Use (EUA) Only
This product has not been FDA cleared or approved, but has been authorized for emergency use by FDA under an EUA for use 
by authorized laboratories.

This product has been authorized only for the detection of nucleic acid from SARS-CoV-2, not for any other viruses or 
pathogens.

The emergency use of this product is only authorized for the duration of the declaration that circumstances exist justifying the 
authorization of emergency use of in vitro diagnostics for detection and/or diagnosis of COVID-19 under Section 564(b)(1) of the 
Federal Food, Drug and Cosmetic Act, 21 U.S.C. § 360bbb-3 (b)(1), unless the declaration is terminated or authorization is 
revoked sooner.

COVID-19Direct RT-PCR
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